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ГЛАВА 1 
 

ВВЕДЕНИЕ В BERNINA QUILTER 
------------------------------------------- 

 
 
 
 
 
 
 

Пэчворк – это популярная техника компоновки и сшивания 
лоскутов ткани в блоки. Программа BERNINA Quilter 
может быть использована для размещения лоскутных 
узоров на квилтах по существующим или по создаваемым 
собственноручно проектам. Используйте эту программу 
для экспериментирования с лоскутами ткани и цветом, 
чтобы создавать прекрасные квилты, отражающие вашу 
индивидуальность. 
Блоки на квилте могут быть заполнены лоскутами 
узорчатой или одноцветной ткани. В программу BERNINA 
Quilter включает в себя большую коллекцию блоков 
пэчворка и тканей, но вы можете сканировать 
собственные блоки и сохранять их в библиотеке квилтов. 
После завершения работы с проектом квилта вы можете 
распечатать его с отображением блоков, их конструкции, а также информации, 
относящейся к расходу ткани, шитью и кройке лоскутов. 
В этом разделе дается обзор техники пэчворка и квилта. 

 

Проекты стежки пэчворка 

Пэчворк и квилт являются 
взаимосвязанными и взаимодополняющими 
техническими приемами шитья. Программа 
BERNINA Quilter является важным 
инструментом проектирования, который 
должен вам помочь компоновать квилты, 
комбинируя лоскутные узоры, вышивки и 
аппликации. Используйте программу 
BERNINA Quilter для составления и 
компоновки блоков пэчворка на экране, 
выбора тканей и добавления украшений, 
таких как вышивки и аппликации. 

 
Пэчворк  
"Блок пэчворка" – это набор сшитых вместе 
лоскутов, образующих обычно фигуру 
правильной формы, такую как 
прямоугольник. "Лоскут" – это одиночный 
кусок ткани, сшитый с другими кусками, 
скомпонованными в блок пэчворка. 
Сшивание лоскутов в блоки называют 
"стачиванием". 
                                                                                        

                               
 
 
 
одиночный 
лоскут  
  
 

Блок пэчворка,  
составленный  
из лоскутов ткани 
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Блоки затем сшиваются вместе по прямой 
или диагональной сетке. 
 

 
Квадратная структура      Ромбовидная структура 
 
 
Хотя в некоторых квилтах блоки пэчворка 
доходят до самых краев, в большинстве случаев 
применяется одна или несколько окантовок. В 
некоторых квилтах используются узкие полоски 
ткани, разделяющие блоки пэчворка. Окантовки и 
межблоковые полоски могут изменять размеры и 
внешний вид вашего квилта. Их можно 
использовать для образования рамки и 
сглаживания слишком контрастных проектов. 
Окантовки могут быть также использованы для 
увеличения размеров квилта, чтобы он подходил 
к размеру стандартной кровати. В каждом квилте 
может быть несколько окантовок. 

     
с окантовками и межблоковыми полосками 
 
Во многих квилтах используется комбинация 
одинаковых по цвету тканей в качестве фона. 
Узоры пэчворка создаются по контрасту между 
светлыми, средними по тону и темными тканями. 
Контраст по насыщенности цвета является 
критическим для некоторых квилтов.  

 
Следует рекомендовать выбирать цвет фона 
перед принятием решения о других цветах 
проекта. 

 
контраст между светлыми, средними и темными 

тканями 
 
При тщательном подборе и размещении лоскутов 
ткани может быть создан трехмерный эффект. 
Сплошные или однотонные цвета размещают 
таким образом, чтобы создавать четкие 
контрасты между блоками пэчворка. При работе с 
одним цветом используйте несколько типов 
ткани.  
          

 
создание трехмерного   использование  
эффекта    доминирующего цвета 
 
Программа BERNINA Quilter позволяет также 
добавлять к квилту аппликации и вышивки. 
 

 
12-элементный 

блок 
 

 

 
 
блок с  
аппликацией 

 

окантовка со 
скошенными 
углами, без 

межблоковых 
полосок 

 

 
блок с  
вышивкой 

 
 

 квадратный квилт с 4 
блоками 
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При планировании квилта определите его общие 
размеры, затем рассчитайте, сколько должно 
быть использовано блоков, окантовок и 
межблоковых полосок. Определите, какие блоки 
пэчворка будут использованы и какие будут 
выбраны цвета. Просмотрите различные 

расположения блоков и различные 
сочетания цветов, чтобы выбрать 
наиболее подходящее. 

 
Стежка квилта 
Квилт подобен сэндвичу, образованному из трех 
слоев:  
◄ Верх квилта: стачанные лоскуты ткани, 

обычно образующие правильные формы, 
такие как прямоугольник, с добавлением при 
необходимости окантовок и межблоковых 
полосок.  

◄ Прокладка: слой объемного материала 
между верхней и нижней сторонами квилта, 

придающий квилту 
рельефность.  

◄ Подкладка: цельный кусок ткани, 
подкладываемый под прокладку. 

 
 
Верх квилта: 
 
Материал прокладки 
 
Ткань подкладки 

 
 
При стежке квилта простегиваются декоративные 
элементы квилта. Простегивающими строчками 
квилт делится на выпуклые декоративные узоры. 
Стежку квилта можно выполнять вручную или на 
швейной машине со свободной подачей 
материала. 
Совет: Квилтом может быть комбинация 
пэчворка с квилтом при использовании блоков 
пэчворка, стачанных простегивающими 
стежками. 

Таблица перевода в 
метрическую систему единиц 
В программе BERNINA Quilter для измерения 
длины используются дюймы.  
 
Для перевода единиц британской системы 
измерения в метрические единицы пользуйтесь 
приводимой ниже таблицей. В некоторых случаях  
это удобнее, чем пользоваться калькулятором. 
 
Метрическая Британская Десятичная 

система (мм) система (дюйм) система (дюйм) 
3 1/8 0.125 
6 1/4 0.25 
9 3/8 0.375 
12 1/2 0.5 
16 5/8 0.625 
19 3/4 0.75 
22 7/8 0.875 
25 1 1.0 
50 2 2.0 
75 3 3.0 
100 4 4.0 
130 5 5.0 
150 6 6.0 
225 9 9.0 
250 10 10.0 
300 12 12.0 
450 18 18.0 
500 20 20.0 
900 36 (1 ярд) 36.0 
1000 (1 метр) 40 40.0 
 
Размеры квилта 
В следующей таблице приведены 
ориентировочные размеры наиболее 
распространенных квилтов. Эти размеры могут 
изменяться в зависимости от используемых 
блоков. 
 
Квилт Британская 

система (дюйм) 
Метрическая 
система (мм) 

Бэби 36-45 x 45-54 90-115x115-137 
Детская 
кроватка 

42-48 x 54-60 107-122x137-152 

Одинар-
ный 

56-64x84-100 142-162x213-254 

Двойной 70-80x84-100 178-203x213-254 
Квин 76-84x90-104 193-213x228-264 
Кинг 92-100x90-104 234-254 x 228-264 
Джамбо 120-124 x 120-124 304-315x304-315 
 

Запуск программы BERNINA 
Quilter  

 
Выбрать: Общие> Доступ к приложениям > 
Вспомогательные приложения > 
Портфолио, Вышивка крестом и Quilter. 
Приложение BERNINA Quilter запускается из 
вышивального ПО  BERNINA Embroidery 
Software . 
 
Запуск программы BERNINA Quilter 
 
Запустите вышивальное  ПО  BERNINA 
Embroidery Software. В разделе «Вышивка по 
канве» выберите Доступ к приложениям и 
Quilter 
 
 
 
 
Выбрать Quilter . 

  
Программа BERNINA Quilter запускается 
также нажатием  клавиш Ctrl+Q. 
 

 

 



Глава 1: Введение в технику пэчворка и квилта 

 

BERNINA
®
  Программа Quilter 4 

BERNINA Quilter имеет собственное меню 
 

Строка заголовка 
Строка  меню 

Панель  
инструментов  
блокирования 

 
Панель  

инструментов  
правки 

Панель размещения 
  
          
 
 
 
 
 
 
 
 
 
 
 
 
    Используемые блоки     Используемые цвета    Используемые ткани 
 

 

Стандартная 
панель 

инструментов 
Палитра тканей 
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Основания 
Образцы используют разные элементы 
вышивки из обычных проектов.  
 
Изменение настроек сетки 

 
Нажмите инструмент Show Grid (панель 
Standard), чтобы отобразить или скрыть 

сетку. Щелчок правой кнопкой мыши 
открывает диалоговое окно Grid. 

 
Программа BERNINA Quilter дает возможность:  
◄ показать или скрыть сетку 
◄ установить интервал сетки 
◄ выровнять объекты по сетке или другим 

контурам. 
 
Примечание: В программе BERNINA Quilter 
используются дюймы для измерения проектов, в 
отличие от вышивальной программы, в которой 
используются региональные настройки Windows 
(обычно миллиметры). 
 
Как изменить настройки сетки 
1 Щелкните правой кнопкой мыши по значку      
Show Grid (Сетка). 

 
 Появится диалоговое окно Options с открытой 
закладкой Grid.  
 

 
Выберите 
Show Grid 

 
Установка 
базисной 

точки 
 

Установка 
интервала 

сетки 
 

Выровнять 
по сетке 

 
Опция Smart 

snap 
 

2  Проставьте флажок в окошке Show 
Grid, чтобы отобразить сетку. 

3  Проставьте флажок в окошко Set Reference 

Point (Установить базисную точку). 
 Например, вы можете установить базисную 

точку сетки в центре проекта. Это более 
простая и быстрая операция, чем 
перемещение всего проекта. 

4  Введите значения интервала сетки (Grid 
Spacing) для горизонтальных и вертикальных 
линий. 

5 Проставьте флажок в окошке Snap to Grid 
(Выровнять по сетке). 

 
Объекты выравниваются по сетке только в 
том случае, если они находятся близко от 
линии сетки. 
 
Совет: Для временной отмены опции Snap to 
Grid во время оцифровывания удерживайте 
нажатой клавишу Alt. 

6 Выберите опцию Smart Snap (при 
отключенной опции Snap to Grid), чтобы 
привязать каждую оцифровываемую точку 
или контрольную точку изменения формы к 
существующим контурам. 

7 Нажмите кнопку ОК. 
 Если вы выбрали опцию Set Reference Point, 

наметьте базисную точку на вашем проекте. 
Сетка будет выровнена, так чтобы 
горизонтальные и вертикальные линии сетки 
пересекались в этой точке. 

 
Совет: Чтобы скрыть линии блоков, нажмите 
Ctrl + L. 

 
Просмотр информации о проекте 
квилта. 
Диалоговое окно Quilt Properties (Свойства 
квилта) предоставляет информацию о 
количестве блоков, аппликациях и вышивках в 
проекте квилта. Используйте закладку Summary 
для добавления своего имени, а также 
вышивальной и общей информации. Имя Author 
включается в распечатки. 
 
Как просматривать информацию о 
проекте квилта 
1  Выберите File > Quilt Properties. 
 
 Откроется закладка Quilt  диалогового окна 

Quilt Properties..  
 

 
2 Введите свое имя и другую информацию, 

которую вы хотите сохранить в проекте 
квилта. 
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3 Нажмите кнопку ОК. 
 
Сохранение проектов BERNINA Quilter  

 
Используйте кнопку Save (панель 
Standard) для сохранения файлов 

программы BERNINA Quilter.  
 
Сохраняйте проект во время работы, как можно 
чаще. Проекты BERNINA Quilter сохраняются в 
формате ARQ, который может быть считан 
только в BERNINA Quilter. Шаблоны файлов 
сохраняются в формате AMQ. 
 
Как сохранять проекты BERNINA Quilter  
1  Выберите File > Save. 
 Если вы сохраняете проект в первый раз, 

откроется диалоговое окно Save As 
(Сохранить как …). Файл следует сохранить 
как ARQ-файл. 

2  Из списка Files of Types (Тип файла) выберите 
BERNINA Quilter (ARQ). 

 
 
 Примечание: Вы можете сохранить проект 

только в формате ARQ.  
3 Введите новое имя для проекта и нажмите 

Save. 

Настройка компоновки квилта 
 
Используйте инструмент Quilt Layout 
(панель Edit) для настройки компоновки 
квилта. 

 
Когда вы создаете новый проект квилта, вы 
определяете формат блоков, добавляете 
полоски между блоками и одну или несколько 
окантовок по краям квилта. Вам нужно установить 
компоновку квилта перед тем, как сможете 
добавить ткани, цвета, аппликации или вышивки. 
Компоновка квилта основывается на формате 
блоков, который может быть изменен:  
◄ вращением блоков на их точках, 
◄ изменением количества блоков в рядах и 

столбцах или 
◄ изменением размеров блоков. 
 
Примечание: Определите компоновку квилта до 
добавления тканей, цветов, аппликаций или 
вышивок. 
 
Изменение расположения блоков 
Блоки могут быть расположены горизонтально, 
образуя квадратную структуру, или по диагонали,  
образуя ромбовидную структуру.  
 

 
         Ромбовидная структура  Квадратная структура  
 
 
Как изменить расположение блоков 
1  Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  

 
 Откроется диалоговое окно Quilt Layout. 

 
3  Выберите формат:  

◄ Rectangular (Прямоугольный) 
◄ Diamond (по диагонали) 
◄ On-point (Ромбовидный) 

4  Нажмите кнопку ОК. 
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Прямоугольные блоки 

   
    Ромбовидные блоки 
 
Изменение количества блоков 
 
Вы можете изменить внешний вид квилта, 
изменив количество блоков в рядах и столбцах.  
 

 
Тот же размер блока, но  
разное их количество  

 
Как изменять количество блоков 
1 Откройте проект квилта. 
2 Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 

 
 

Введите количество  
блоков 

 
 
 
 
 
 
 
3  Введите опции Blocks:  

◄ Blocks across (Блоки в ширину) 
◄ Blocks down (Блоки по высоте) 

 
 
 
 
 

 
 

 
 
 
4  Нажмите кнопку ОК. 
 
Изменение размеров блоков 
Вы можете изменить внешний вид квилта, 
изменив размеры блоков. 

 
То же количество блоков, но с разными размерами 
 
Как изменять размер блоков 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  

Откроется диалоговое окно Quilt Layout. 
 

выбор ширины блоков 
3. Выберите параметры блоков 
- ширину блоков 
- высоту блоков 
 
4 Нажмите кнопку ОК. 

Добавление полосок между 
блоками 
 
Для разделения блоков между ними могут быть 
вставлены узкие полоски ткани. Иногда в местах 
соединения добавляют небольшие 
соединительные квадраты. Вы можете также 
добавить полосу окантовки, в зависимости от 
выбранного стиля межблоковых полосок. 
 
Добавление межблоковых полосок 
Полоска между блоками может быть добавлена и 
определена: 
◄ изменением ширины полоски, 
◄ изменением стиля полоски, 
◄ добавлением полосы окантовки. 

 

 
Полоски между ромбовидными    Полоски  
блоками             между 
 квадратными  
  блоками 
 
При добавлении межблоковых полосок размеры 
квилта увеличиваются в соответствии с шириной 
полосок. Размеры блоков остаются теми же. 
 

Блоки в ширину: 4  
Блоки по высоте: 4 

Блоки в ширину: 4  
Блоки по высоте: 6 
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Как добавлять полоски между блоками 
1  Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 
 
 
 
 
Выбор 
стиля 
полоски 
 
 
 
 
3 Выберите стиль межблоковой полоски. 
 
Примечание: Стили полосок различны для 
квадратных и ромбовидных блоков. 
 

 
no sashes  
(без полосок) 

sash squares 
(квадратное 
расположение 
полосок) 

horizontal sash 
(горизонтальные 
полоски) 

 
horizontal sash on  
top 
(горизонтальные 
полоски сверху) 

vertical sash 
(вертикальные 
полоски) 

vertical sash on 
top 
(вертикальные 
полоски сверху) 

 
Примечание: При выборе опции None опция  
Sash Border (Окантовка полоской) отключается. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
4  Проставьте флажок в окошке Sash Border для 

добавления полоски окантовки вокруг квилта. 
 
 
 
 
 
 
 
 
Выбор полоски 
окантовки 
 
 
Окантовка отображает выбранный вами стиль 
межблоковой полоски, т.е. если вы выбрали 
горизонтальную полоску, то окантовка 
добавляется только к верхней и нижней стороне 
квилта. 

 
полоски вокруг квадратов окантовка,  

добавленная ко всем 
сторонам  

 
горизонтальные полоски  окантовка,  

добавленная к верхней 
и нижней сторонам 

 
вертикальные полоски   окантовка,  

добавленная к боковым 
сторонам 

5  Нажмите кнопку ОК. 

без полосок 

 
квадраты 

 
назад 

 
вперед 
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Изменение ширины полоски 
Ширину полоски между блоками можно изменять. 
     
 
 
 
 
 
 
 
 
 
 
 
Как изменять ширину полоски 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 
 
Настройка 
ширины 
полоски 
 
 
 
 
 
3  Выберите стиль межблоковой полоски. 
4  Введите ширину полоски (Sashes Width). 

   
ширина полоски: 1 дюйм  ширина полоски:  

2 дюйма 
 
5 Нажмите кнопку ОК. 
 

Добавление окантовок вокруг 
квилта 
По наружному краю квилта можно добавить одну 
или несколько окантовок. Окантовки могут 
отображать стиль квилта, нужно выбрать 
квадратный, скошенный, вертикальный, 
горизонтальный или блочный стиль. 
 
Добавление окантовок 
Добавление окантовки означает размещение 
окантовки по наружному краю квилта, в то время 
как вставка окантовки означает размещение 
окантовки внутри выбранной окантовки. 

 
Как добавлять окантовки 
1 Откройте проект квилта. 
2 Щелкните по значку Quilt Layout. 
 Откроется диалоговое окно Quilt Layout. 
3 На панели Border (Окантовка) нажмите 

кнопку Add. 
 Новая окантовка будет добавлена и 

выделена. 
 
 
Добавить новую 
окантовку 

 
 
 
 
 
 
 
 
 
 
 
 

Совет: Нажмите кнопку Add еще раз, чтобы 
добавить  еще одну окантовку.   
 
4  Нажмите кнопку ОК. 

 
Без окантовки   Одинарная    Двойная  

окантовка     окантовка 
 
Вставка окантовок 
Внутрь выбранной окантовки можно вставить 
одну или несколько окантовок. 
 
Как вставить окантовки 
1  Откройте проект квилта. 
2 Щелкните по значку Quilt Layout.   

Откроется диалоговое окно Quilt Layout. 
 
 
 
Вставить новую 
окантовку 
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Примечание: Чтобы активировать кнопку  
Insert, нужно добавить окантовку.  
 
3 Выберите окантовку. 
 
 
 

Выбранная 
окантовка выделена 

 
 
 
 
4 На панели Border (Окантовка) нажмите 
кнопку Insert. 
 
 

Вставлена новая  
окантовка 

 
 
 
 
 Новая окантовка вставлена внутрь 

выделенной окантовки. 
 

Совет: Нажмите кнопку Insert еще раз, чтобы 
вставить еще одну окантовку.  
 

5 Нажмите кнопку ОК. 
 
Удаление окантовок 
Окантовки можно удалять так же просто, как и 
вставлять.  

 
 
Как удалять окантовки 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 

Выберите окантовку для  
удаления 

 
 
 
 
 
 
3 Выберите окантовку для удаления 

 
4  На панели Border (Окантовка) нажмите 
кнопку Delete. 

 
Совет: Нажмите кнопку Delete еще раз, чтобы 
удалить следующую окантовку.   
 

5  Нажмите кнопку ОК. 
 
Изменение стиля окантовки 
Окантовки квилта могут быть изменены с 
использованием различных стилей. Каждая 
окантовка может быть выполнена в разном стиле. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как изменить стиль окантовки 
1 Откройте проект квилта. 
2 Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 

   
 
 
 
 
 

 
 
 
 
 
 

3  Выберите окантовку. 
4 Выберите стиль окантовки: 

  
 
Углы: скошенный, квадратный, горизонтальный 
5  Нажмите кнопку ОК. 
 
Изменение ширины окантовки 
Ширина окантовок квилта может быть подогнана 
к точным размерам квилта. Если вы выбрали 
окантовку прямоугольниками, то вы можете также 
изменить количество прямоугольников вдоль 

Выбор стиля окантовки 
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каждой стороны или же превратить 
прямоугольники в квадраты. 
 

Как изменить ширину окантовки 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
3  Выберите окантовку. 
 
 

 

 
 
 
 
 
 
 
 
Ввод ширины 
окантовки 
 
 

 
4  Введите ширину окантовки 

 
увеличенная ширина окантовки 

 
5  Нажмите кнопку ОК. 
 
Настройка параметров окантовок 
прямоугольниками 
Окантовки прямоугольниками могут быть 
изменены таким образом, что ширина верхней и 

нижней окантовок будет отличаться от ширины 
боковых окантовок. Вы можете также изменить 
количество прямоугольников вдоль каждой 
стороны или же превратить прямоугольники в 
квадраты. 
 
Как изменять окантовки 
прямоугольниками 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  

Откроется диалоговое окно Quilt Layout. 
 

 
3 В поле Borders выберите Rectangles. 
 

 
 
 
 
 
 
 
 
 
Ввод числа 
прямоугольников 
окантовки 
 
 
 

 
4 Введите число прямоугольников окантовки.  

◄ Across (По ширине): в поперечном 
направлении по верхней и нижней 
сторонам квилта.  

◄ Down (По высоте): в продольном 
направлении по боковым сторонам 
квилта. 

 
Примечание: Количество прямоугольников 
окантовки не обязательно должно 
соответствовать количеству блоков в квилте в 
поперечном и продольном направлениях. 

    

 
      По ширине: 2   По ширине: 3   По ширине: 4  

По высоте: 2   По высоте: 4    По высоте: 4 
 
5  Введите высоту прямоугольников окантовки в 

поперечном направлении и их ширину в 
продольном направлении.  
◄ Height (Высота): высота 

прямоугольников окантовки.  
◄ Width (Ширина): ширина прямоугольников 

окантовки. 
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Высота: 1" 
Ширина: 3" 

Высота: 2" 
Ширина: 2" 

Высота: 3" 
Ширина: 1“ 

 
 
6 Проставьте флажок в окошке Square 

(Квадрат), чтобы превратить прямоугольники 
окантовки в квадраты по ширине (Across) 
и/или высоте (Down) квилта. 

 
 
 

 
Выбрана функция     Квадраты по ширине: 4  
Squares Across   Квадраты по высоте: 4 
 
 

7 Нажмите кнопку ОК. 
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ГЛАВА 2 
 

ОСНОВНЫЕ СВЕДЕНИЯ О 

ПРОГРАММЕ BERNINA QUILTER 
------------------------------------------- 

 
 
 
 
 
 
 
 
 

В программе BERNINA Quilter вы можете создавать 
и отображать на экране весь проект квилта, 
выбирать блоки, изменять цветность и добавлять 
ткани, затем редактировать проект и просматривать 
всю компоновку квилта. Можно распечатать схему 
завершенного квилта, как всего квилта и всех 
компонентов из блоков пэчворка и лоскутов, так и 
шаблонов для выкройки лоскутов и блоков 
пэчворка. Программа BERNINA Quilter может также 
рассчитать и выдать на печать расход каждой ткани 
в данном проекте. 
В этом разделе поясняется, как настраивать проект 
квилта, как добавлять блоки пэчворка, а также как 
располагать блоки пэчворка и ткани на экране.  
Также описывается, как распечатывать проект 
квилта и как обращаться с файлами проектов.
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Использование изображений 
 
Растровые изображения могут быть вставлены 
или отсканированы в программу BERNINA Quilter 
для использования в качестве оригиналов для 
оцифровывания вышивок, аппликаций или 
образцов ткани. Как и в ПО  BERNINA, вы можете 
временно показывать или скрывать растровый 
оригинал. См. Оцифровывание с оригиналом в 
Руководстве пользователя. 
 
Сканирование оригиналов и тканей 

 
Используйте команду Scan Picture (меню 
Edit) для сканирования растрового 
изображения или ткани в BERNINA Quilter. 

 
Сканирующие функции BERNINA позволяют вам 
использовать большинство совместимых с 
протоколом TWAIN сканеров. Вы можете 
использовать любое ПО сканера, если оно 
способно сохранять изображения в одном из 
совместимых форматов. 
Если вы сканируете ткань, установите 
сканирование на 256 цветов, 100 % и 72 dpi. 
Такие настройки позволят получить файл 
небольшого размера, который будет хорошо 
отображаться на экране, не занимая много места 
на жестком диске или в памяти компьютера. 
 
Совет: Если нужно изменить размеры или 
повернуть изображение, то лучше делать это во 
время сканирования. Последующее изменение 
размера может исказить изображение. 
 
Как сканировать оригинал или ткань 
1 Установите ваш сканер. 
 См. раздел Настройка сканера в Руководстве 

пользователя. 
2  Подготовьте оригинал или ткань для 

сканирования. 
3  Создайте новый файл или откройте проект, в 

который вы хотите вставить рисунок ткани. 
4  Нажмите кнопку Scan (Сканировать). 

 Откроется ваша программа сканирования. 
5  Выберите режим сканирования и разрешение. 
 См. раздел Сканирование изображения в 

программу BERNINA. в Руководстве 
пользователя. 

6  Просмотрите изображение в программе 
сканирования. 

7  Выберите зону сканирования и отсканируйте 
изображение. 

8  Сохраните отсканированное изображение в 
совместимом формате, таком как BMP. 

 
Вставка рисунков 

 
Используйте инструмент Load Picture 
(панель Edit) для открытия изображения. 
 
 
Используйте инструмент Scan Picture 
(панель Edit ) для сканирования 
изображения или ткани. 

 
Вы можете вставлять растровые изображения в 

различных форматах для использования в качестве 
оцифровываемых трафаретов или аппликаций. Вы 
можете также вставить растровые изображения или 
ткани для сохранения в Fabrics Library (Библиотеке 
тканей). Подробнее см. в разделе  
Создание образцов ткани. 
 
Как вставить рисунок 
1  Нажмите кнопку New (Создать). Откроется 

новый файл. 
2  Нажмите кнопку Load Picture (Загрузить 

рисунок).  
 Откроется диалоговое окно Load Picture. 

 
 
3  Выберите папку из списка Look In. 

4  Выберите тип файла из списка Files of Type 

(например, BMP). 
5  Выберите файл, который вы хотите вставить. 
 
 Совет: Проставьте флажок в окошке Preview, 

чтобы просмотреть выбранный файл.  
6 Нажмите Open. 
 
Отображение и скрытие рисунка 

 
Щелкните по инструменту Show/Hide Images 
(панель Standard ), чтобы отобразить или 

скрыть рисунок. 

 
Вы можете отобразить или временно скрыть 
растровый трафарет.  
 
Как отобразить или скрыть рисунок 
◄ Щелкните по значку Picture (Рисунок), чтобы 

просмотреть изображение.  
◄ Щелкните еще раз, чтобы скрыть изображение. 
 
отображаемый рисунок 

 
       скрытый рисунок 
 

Добавление блоков и тканей к 
квилту 
В программе BERNINA Quilter вы используете 
встроенную "Библиотеку" (Library) для добавления 
блоков пэчворка в квилт. Они сохранятся в Blocks 
Library (Библиотеке блоков). Если вы добавили их в 
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проект, то затем вы добавляете выбранные вами 
ткани. Цвета и ткани, которые вы скомплектовали 
для проекта квилта, помещаются в Библиотеку 
цветов (Colors Library), содержащей чистые 
цвета, или в Библиотеке тканей (Fabrics Library), 
содержащей подборку отсканированных тканей. 
 
Библиотека блоков 
 
Библиотека блоков (Blocks Library), содержит 
традиционные проекты пэчворка, такие как Log 
Cabin или Wild Goose Chase, которые могут быть 
использованы в качестве исходной формы для 
вашего проекта.  
 
Используйте один тип блока по всему квилту или 
несколько подобранных друг к другу блоков. Вы 
можете изменять внешний вид квилта путем 
вращения блоков, изменения цвета и узоров 
используемых тканей. Поэкспериментируйте с 
различными эффектами, пока не получите то, что 
вам понравится. 
 
 
 
Выбор блоков,                                               
Текущий выбор 
цвета или ткани 
 
 
 
 
 
 
 
Выбор блока 
 
 
 
Разворачивание  
или  
сворачивание  
узла 
 
 
Когда вы оцифровываете свой квилт, вы можете 
распечатать список с указанием расхода каждой 
ткани для данного проекта, а также шаблоны для 
выкройки лоскутов с учетом или без учета 
припусков на шов. 
 
Библиотека цветов 
 
Библиотека цветов (Colors Library) включает в 
себя диапазон чистых цветов с подразделением 
на светлые, средние по тону и темные оттенки     
 
 
 

Выбор цветов  
для 

отображения  
одноцветной 

ткани 
 

Выбор 
светлого,  

среднего или  
темного 
оттенка 

 
Выберите чистый цвет из Библиотеки цветов, 
чтобы он соответствовал имеющейся у вас 

одноцветной ткани,  
или используйте цветную распечатку, чтобы 
подобрать подходящий цвет ткани из сохраненных 
вами тканей. 
 
 
Библиотека тканей 
 
Библиотека тканей (Fabrics Library) содержит 
коллекцию отсканированных образцов ткани из 
ассортимента фирмы Benartex. Они могут быть 
заказаны на фирме Benartex или приобретены в 
местном магазине тканей.   
Номер заказа указывается во всплывающей 
подсказке. Ткани упорядочены по категориям 
похожих друг на друга тканей. Вы можете добавлять 
в эту библиотеку собственные образцы 
отсканированных тканей. 
 
  
 

 

 
 
 

Примечание: Вы можете также сканировать 
одноцветные ткани и сохранять их в Библиотеке 
тканей. См. также Управление трафаретами и 
образцами тканей. 
 
Добавление блоков пэчворка к квилтам  
 

 

Используйте инструмент Library (меню 
Edit) для отображения и выбора блоков 
пэчворка.  
 
 
Используйте инструмент Paintbrush 
(меню Edit) для выбора и добавления 
блоков пэчворка к квилту.  
 

 
 
Библиотека блоков (Block Library) содержит 
ассортимент блоков пэчворка, упорядоченный по 
категориям. Вы можете заменять блоки в любое 
время. Если вы добавили их в проект, то затем вы 
добавляете выбранные вами ткани. 
 
Как добавлять блоки пэчворка к квилту 

Текущий  
выбор 

 
Выбор ткани  

из 
ассортимента  

Benartex  
 
 
 

Выбор блока 
 
 

Разворачивание  
или  

сворачивание  
узла 
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1  Откройте программу BERNINA Quilter и 
проведите настройку компонентов квилта. 

 Подробнее см. в разделе Настройка 

компоновки квилта. 
2  Нажмите кнопку Paintbrush (Кисть). 
 В правой части окна проекта откроется 

диалоговое окно Library. 
3 Нажмите кнопку Blocks (Блоки). 
 Появится список всех предварительно 

определенных блоков пэчворка с 
подразделением на категории. 

4  Щелкните по знаку "+" у названия категории, 
чтобы увидеть содержание категории. 

 
 
 
Выбор блоков,                           
цвета или ткани 
 
 
 
 
 
 
Выбор блока 
 
Разворачивание  
или  
сворачивание  
узла 
 
 
 
 
 
 
5  Выберите блок или блоки для квилта.  
 Для выбора нескольких блоков:  

◄ обведите ограничивающий 
прямоугольник вокруг группы блоков или, 

◄ удерживая нажатой клавишу Ctrl, 

щелкайте мышью по нужным вам блокам. 
6  Выберите блок пэчворка из Библиотеки.  

Блок пэчворка будет скопирован в окно 
проекта. 

 

 
 

Если выбрано больше одного блока, то блок 
пэчворка копируется во все выделенные 
блоки. 

     

 
Выбранные блоки    Все выделенные блоки  
выделены    заполнены образцом из  

Библиотеки 
 
7 Продолжайте выбирать блоки пэчворка по 
своему желанию. См. также Добавление блоков 
пэчворка к квилтам. 
 

Совет: Чтобы добавить один из образцов ко всем 
блокам квилта, удерживайте нажатой клавишу 
Ctrl и щелкните по любому блоку квилта.  
 

 
 
Просмотр тканей 
Образцы тканей в библиотеке имеют небольшой 
размер и не дают представления о действительном 
внешнем виде. Вы можете отобразить большой 
образец любой такни с натуральным размером 
узора. 
 
Как просмотреть ткань 
1 В окне Library выберите ткань: 

◄ щелкните по кнопке Colors для чистых 
цветов,   

◄ щелкните по кнопке Fabrics для тканей.  
2 Нажмите клавишу Alt, щелкните по образцу ткани 

и удерживайте нажатой кнопку мыши. Образец 
ткани заполнит все окно проекта с отображением 
рисунка в масштабе 1:1. Как только вы отпустите 
кнопку мыши, экран возвратится в нормальный 
режим. 

 

Текущий  
выбор 
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Добавление тканей к квилту 
 
Используйте инструмент Library (панель 
Edit) для отображения и выбора чистого 
цвета или тканей для квилта. 
 
Используйте инструмент Paintbrush (меню 
Edit) для выбора и добавления тканей к 
квилту.  

 

Добавляйте одноцветные или узорчатые ткани к 
индивидуальным блокам или ко всему квилту. 

 Как добавлять ткани к квилту 
1 Откройте проект квилта. 
2 Нажмите кнопку Paintbrush (Кисть). 
3  Выберите Colors (Цвета) или Fabrics (Ткани) 

в диалоговом окне Library:  
◄ Для чистых цветов нажмите кнопку 

Colors, затем выберите тон – светлый, 
средний или темный.  

◄ Для тканей нажмите кнопку Fabrics, затем 
щелкните по знаку "+", чтобы отобразить 
образцы тканей. 

4  Выберите нужный вам цвет ткани. 
5 Щелкните по блоку, в котором вы хотите 
поместить ткань. 

 
 
 
Щелкните, чтобы 
поместить ткань 
 
 
 

 
6  Продолжайте эти операции, пока не добавите 
все ткани. 

   
 
 
 
 
 
 
 
 
 

Совет: Чтобы добавить один из образцов ткани 
ко всем блокам квилта, удерживайте нажатой 
клавишу Ctrl и щелкните по любому блоку квилта.  

 
 
Добавление тканей к лоскутам пэчворка 
Вы можете добавлять ткани к лоскутам пэчворка 
индивидуально или по группам. 

   
 
 
Как добавлять ткани к лоскутам пэчворка 
1  Откройте проект квилта. 
2  Добавьте блоки пэчворка. 
 Подробнее см. в разделе Добавление блоков 
пэчворка к квилтам. 
3  Нажмите кнопку Paintbrush (Кисть). 
4  Выберите Colors (Цвета) или Fabrics (Ткани) в 
диалоговом окне Library:  

◄ Для чистых цветов нажмите кнопку Colors, 
затем выберите тон – светлый, средний или 
темный.  

◄ Для тканей нажмите кнопку Fabrics, затем 
щелкните по знаку "+", чтобы отобразить 
образцы тканей. 
 

5  Выберите цвет или фактическую ткань. 
   

Оригинальный  
квилт 

 
 
 
 
 
 
 
 
6 Щелкните в том месте, куда вы хотите поместить 
цвет или ткань. 
 

  
 
 
Щелкните, чтобы  
поместить ткань 
 

 
7  Продолжайте эти операции, пока не добавите все 
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ткани. 

      
Совет: Чтобы добавить ткань ко всем 
геометрически подобным лоскутам пэчворка, 
удерживайте нажатой клавишу Ctrl во время 
щелканья мышью.  

 
 
Просмотр блоков и тканей, 
используемых в проекте 
 
На панелях под окном проекта отображается до 
восьми блоков пэчворка, цветов или образцов 
ткани, использованных в проекте. 
 
Как просматривать блоки и ткани, 
используемые в проекте 
◄ Используйте кнопки прокрутки (< или >) для 

перемещения картинок на одну ячейку влево 
или вправо. 

     
 
◄ Щелкайте по кнопкам прокрутки (« или ») для 

перемещения к концу ряда влево или вправо. 
 

Примечание: Блоки показываются в том 
виде, в котором они изображены в окне 
библиотеки, т.е. с тем же цветом, 
ориентацией и формой, даже если блоки 
квилта были изменены по цвету, повернуты 
и/или перекошены. 

Просмотр проектов квилта 
 
BERNINA Quilter предоставляет несколько 
возможностей просматривать проекты, чтобы 
облегчить работу с ними. Увеличьте изображение 
на экране, чтобы рассмотреть проект  в 
натуральном размере или уменьшите 
изображение, чтобы увидеть весь проект. Это 
делается таким же образом, как при изменении 
размеров изображения в ПО BERNINA. Вместо 

прокрутки можно панорамировать проект и быстро 
переходить от одного края проекта к другому. 
 
Вы можете показывать или скрывать элементы 
проекта разнообразными настройками отображения. 
Вы можете показывать или скрывать контуры 
объектов. Можно показывать линейное изображение 
блоков квилта вместе с аппликацией или вышивкой, 
а также версию со смешиванием цветов. 
 
Панорамирование проектов 

 
 Используйте инструмент  Pan (панель General) 
для панорамирования проекта квилта. 

 
В дополнение к линейкам прокрутки 
панорамирование позволяет быстро просматривать 
детали проекта, которые не видны в данный момент 
в окне проекта.  Панорамирование обычно 
используется после изменения размеров 
изображения. 
 
Как панорамировать проект  
1 Выберите значок Pan. 
 Указатель мыши превратится в изображение 
руки. 
 

Совет: Нажмите и удерживайте нажатой 
клавишу пробела, чтобы указатель мыши 
превратился в значок Pan. 

2 Щелкните и перетащите квилт для его 
перемещения в нужное положение. 

     
Перетаскивание изображение 

 
Отображение черных и белых контуров 

 
 Используйте инструмент Show Outlines (панель 
Standard), чтобы отображать только черные 

контуры блоков квилта. 

 
Если у квилта сложный узор, то полезно скрыть все 
цвета ткани и отобразить проект в виде только белых 
и черных контуров. Все блоки, формы аппликаций и 
мотивы вышивок преобразуются в простые контуры. 
Эта техника может быть также использована для 
более четкого просмотра объектов аппликаций при 
изменении формы. 
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Как отображать черные и белые 
контуры 
◄ Нажмите кнопку Show Outlines (Показать 

контуры). Будут отображены только контуры. 

   
         Функция Show     Функция Show  
         Outlines ОТКЛЮЧЕНА  Outlines ВКЛЮЧЕНА 
 
o Щелкните по значку Show Outlines еще раз, 

чтобы переключиться в нормальный режим. 
◄ Просмотрите цветовые блоки без контуров, 

чтобы получить более реалистичное 
представление о готовом квилте, нажав 
клавиши Ctrl + L. 

 
 
 
Просмотр узоров тканей в 
натуральную величину 
 

 Используйте инструмент Show Pattern 1:1 
(панель Standard) для просмотра тканей в 
натуральную величину. 

 
Иногда бывает полезно просматривать набивные 
ткани в натуральную величину. Это позволяет 
легче различать отдельные ткани, особенно если 
используется несколько похожих друг на друга 
тканей. Размеры блоков не изменяются, 
увеличиваются только узоры ткани. 
 
Как просматривать узоры тканей в 
натуральную величину 
◄ Нажмите инструмент Show Pattern 1:1 

(Показать узоры в масштабе 1:1).  

Если выбран этот инструмент, узоры ткани 
отображаются в натуральную величину.  

      

 
Функция Show Pattern    Функция Show Pattern  
1:1 ВЫКЛЮЧЕНА    1:1 ВКЛЮЧЕНА 

  
◄ Нажмите инструмент Show Pattern 1:1 еще 

раз, чтобы уменьшить размер узоров до 
пропорций изображения квилта. 

 
Просмотр сбалансированных оттенков 
цвета 
 

 Используйте инструмент Show Pattern Average 
Color (панель Standard) для просмотра тканей 

со сглаженными оттенками цвета.  
 
Когда вы выбираете ткани для квилта, важно 
подобрать баланс светлых, средних и темных 
оттенков, создающий требуемый вам эффект. 
Используйте инструмент Show Pattern Average Colors 
(Показать сбалансированные оттенки узоров) для 
сведения каждой ткани в усредненный цвет, что 
позволит вам проверить, достигнут ли вами 
правильный баланс оттенков. 
 
Как просматривать сбалансированные 
оттенки цвета 
◄ Щелкните по значку Show Pattern Average Colors. 

Если выбран этот инструмент, то ткань в каждом 
блоке приобретает усредненный цвет. 
 

   
Функция Show Pattern     Функция Show Pattern  
Average Colors ВЫКЛЮЧЕНА  Average Colors ВКЛЮЧЕНА 
  
◄ Щелкните по значку Show Pattern Average Colors 

еще раз, чтобы возвратиться к нормальному 
режиму. 

Упорядочение тканей на палитре 
 
Вы можете разместить подборку тканей на палитре 
для облегчения распознавания и доступа. Вы 
можете использовать, например подборку зеленых 
тканей, для выбора и отображения нескольких 
возможных тканей для использования в квилте. Вы 
можете также использовать подборку тканей, если у 
вас имеется проект квилта, по которому вы хотите 
создать несколько квилтов с разными тканями или 
цветами. 

 
 
Перемещайте цвета и ткани по палитре путем 
перетаскивания мышью. Попеременно переходите 
от одной ткани к другой перетаскиванием мышью. 
Дважды щелкните по цвету на палитре тканей, чтобы 
открыть диалоговое окно Color. 
 
Как упорядочить ткани на палитре 
1  Выберите одноцветную или набивную ткань из 
библиотеки. 



Глава 2:Основные сведения о программе BERNINA Quilter  

 

BERNINA
®
  Программа Quilter 20

 
Примечание: Значок Paintbrush выбирается 
автоматически и превращается в "пипетку", 
когда указатель мыши находится над 
библиотекой.  

2 Щелкните по кнопке To palette (К палитре). 
Копия выбранного блока пэчворка или узора 
помещается в Палитру. 
 

       добавлено в палитру 

 
Щелкните, чтобы 

добавить в палитру 

Настройка цветности 
 
Когда вы добавляете блоки пэчворка и ткани к 
своему квилту, вы можете просто настроить 
оттенки или яркость всего квилта. Вы можете 
также смешивать и сохранять собственные 
цвета. 
 
Настройка оттенка или яркости 

 
 Используйте инструмент Adjust 
Hue/Brightness (панель Edit) для настройки 

оттенка или яркости. 

 
Диалоговое окно Adjust 
Hue/Brightness(Настройка оттенка/яркости) 

может быть использовано для:   
◄ изменения цвета или оттенка всего квилта 

или выбранных объектов, 
◄ настройки яркости всего квилта или 

выбранных объектов. 

 
Примечание: Проекты вышивки при настройке 
оттенка/яркости не затрагиваются. 
 
Как настраивать оттенок или яркость 
1   Откройте проект квилта. 
2 Выделите зону настройки или отмените 

выделение всех фрагментов, чтобы настроить 
весь квилт. 

3 Щелкните по значку Adjust Hue/'Brightness.  
 Откроется диалоговое окно Adjust Hue/Brightness. 

 
  
 
 
 
 
 
Используйте  
ползунки  
для 
изменения  
настроек 
 
 
 
 

4 Перемещайте ползунки для настройки оттенка 
и/или яркости. 

    
Оригинальные цвета   Отрегулированы оттенки 

     
Оттенки отрегулированы в  Отрегулирована  
выбранных фрагментах   яркость 

 
Совет: Проставьте флажок в окошке Preview, 

чтобы обновлять изображение во время 
изменения настроек.   

5 Щелкните по кнопке Hide Color (Скрыть цвет), 

чтобы удалить цвет выбранной зоны или всего 
квилта, если не выбран ни один фрагмент. 
Это поможет просматривать баланс светлого и 
темного в квилте. 

    
Цвет скрыт в   Цвет скрыт по всему квилту 

         выбранных блоках   
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6  Нажмите кнопку ОК. 
 
Смешивание ваших собственных 
цветов  
Из Палитры (Palette) вы можете изменять цвет 
любой одноцветной ткани или создавать и 
сохранять новые цвета тканей, используя 
диалоговое окно Color. 
 
Как смешивать ваши собственные 
цвета  
1 Перетащите мышью одноцветную ткань в 

Палитру тканей (Fabric Palette). 
2 Дважды щелкните по одноцветной ткани а 

Палитре тканей.  
 Откроется окно Color (Цвет).. 
 

  
 

Передвиньте ползунок  
для регулировки яркости 
цвета 

 
3 Из таблицы Basic colors (Основные цвета) 

выберите цвет, который ближе всего подходит 
к нужному вам цвету. 

4 Щелкните мышью и перетащите перекрестие 
нитей по спектру цветов, чтобы получить 
требуемый вам цвет. 

5 Передвиньте ползунок на правой стороне 
окна цветового спектра, чтобы 
отрегулировать яркость цвета. 
В правом нижнем углу диалогового окна Color 

появятся значения HLS 
(Цвет-Яркость-Насыщенность) и RGB 
(Зеленый, Красный, Синий). Введите эти 
значения для точного определения цветов. 

6 После смешивания требуемого цвета 
нажмите кнопку Add to Custom Colors 
(Добавить к пользовательским цветам). 

7 Нажмите кнопку ОК. 
Новый цвет появится в Палитре тканей (Fabric 
Palette). 
 
Печать проектов квилта и блоков 

 
 Используйте кнопку Print (панель Standard) 
для распечатки текущего проекта с 
использованием текущих настроек. 
 
Используйте кнопку Print Preview (панель 
Standard) для предварительного просмотра 
текущего проекта и изменения настроек 
перед печатью. 

 

Создайте печатную копию проекта, используя 
принтер. Настройте опции печати и принтера перед 
печатью или используйте текущие опции. На 
распечатке будут указаны имена квилта и автора. 
Добавьте свое имя в диалоговом окне Quilt Properties 
на закладке Summary. Подробнее см. в разделе 
Просмотр информации о проекте квилта. 
 
Печать проектов квилта 
Распечатка содержит обзор квилта, а также 
основную рабочую информацию, включая размеры 
квилта, блоков и их элементов, аппликаций, а также 
указания по кройке лоскутов и расход ткани. 
 
Совет: Для проверки правильности проекта 
воспользуйтесь функцией предварительного 
просмотра перед печатью. 
 
Как печатать проекты квилта 
1 Выберите File > Print. Откроется диалоговое окно 
Print. 
 

 
2  Выберите принтер, который вы хотите 
использовать. 
 

Примечание: Для изменения настроек принтера, 
нажмите кнопку Options и выберите требуемые 
настройки. 

3  На панели Print What (Что печатать) выберите 
информацию, включаемую в распечатку:  

◄ Blocks (Блоки): Подробнее см. в разделе 
Печать блоков пэчворка.  

◄ Block Construction (Конструкция блока): 
Подробнее см. в разделе Печать 
конструкции блоков пэчворка.  

◄ Appliquй (Аппликация): Подробнее см. в 
разделе Печать форм аппликации.  

◄ Whole Quilt (Весь квилт): Подробнее см. в 
разделе Печать всего квилта.  

◄ Yardage (Расход ткани): Подробнее см. в 
разделе Печать данных о расходе ткани. 

◄ CutTool – инструмент для вырезания (см. 
соответствующую Инструкцию) 

4  Нажмите кнопку Options для изменения 
настроек.  
5  Для предварительного просмотра: 

◄ нажмите кнопку Preview в любом диалоговом 
окне Print Options, 

◄ нажмите кнопку Print Preview или 
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◄ выберите File > Print Preview. 
6  Введите нужное вам число копий. 
7  Нажмите кнопку ОК. 
 
 

Печать блоков пэчворка  
 
Используется для распечатки всей компоновки 
блоков пэчворка, включая блоки, межблоковые 
полоски, соединительные квадраты и окантовку. 

  
 
Как распечатать блоки пэчворка 
1 Нажмите кнопку Print Preview. Откроется 

диалоговое окно Print Preview. 
 

 
2 Выберите опцию Blocks.  
3 Нажмите кнопку Options. 
 Откроется диалоговое окно Print Options 

Blocks (Опции печати блоков). 

 
4 Выберите, нужно ли печатать в натуральную 

величину или назначьте число блоков на 
одной странице. 

5 Выберите, нужно ли печатать в цвете или 
только контуры: 
 
◄ опция Outline: печатаются только линии 

вокруг блоков и его элементов, 
    

 
Опция Color:   печатаются блоки в цвете. 

    
 
6 Выберите диапазон печати, все или только 
выделенную часть.  

◄ Опция All: печатаются все блоки.  
◄ Опция Selection: печатаются только 

выделенные блоки. 
 
Совет: Не забудьте выделить блоки перед печатью. 
7  Проставьте флажок в окошке Print Guide, чтобы 
распечатать справку по квилту. 

В этой справке дается контурная схема всего 
квилта с номером каждого элемента, которые 
будут напечатаны на следующих страницах. Этот 
же номер появится около элемента, который 
будет напечатан отдельно. 
 
Совет: Для перехода от страницы к странице 
нажимайте кнопки Next Page и Previous Page.  

8  Нажмите кнопку Print. 
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Печать конструкции блока пэчворка  
 
Конструкция 
блока включает 
индивидуальные 
лоскуты, из 
которых 
составлен блок, 
межблоковые 
полоски, 
соединительные 
квадраты и 
элементы 
окантовки. 
Каждый лоскут печатается с назначенным 
припуском на шов. Распечатка подразделяется 
на секции блока, начинающиеся 
непосредственно после печати справки. В каждой 
секции печатается все, что требуется для блока. 
Каждая секция блока начинается со справки 
блока, напечатанного в масштабе 1:5, с 
буквенными кодами, идентифицирующими 
положение лоскутов в блоке. 
 
Используйте этот метод для печати блоков, 
которые включают аппликацию как часть блока.  
См. раздел Печать форм аппликации для печати 
аппликаций, созданных с использованием 
инструмента рисования аппликаций. 
 
Как распечатать конструкцию блока 
пэчворка 
1 Нажмите кнопку Print Preview 

(Предварительный просмотр).  
 Откроется диалоговое окно Print Preview. 

    
 
2 Выберите Block Construction (Конструкция 

блока). 
3 Нажмите кнопку Options. Откроется 

диалоговое окно Print Options Block 
Construction (Печать опций конструкции 
блока). 

 
 
 
 
 
 
 
 
 
 
 
 

4 Выберите, нужно ли печатать в натуральную 
величину или назначьте число блоков на одной 
странице. 

5 Выберите диапазон печати, все или только  
      выделенную часть.  

◄ Опция All: печатаются все блоки. 
     

 
◄ Опция Selection: печатаются только 

выделенные блоки. 
 

 
Совет: Не забудьте выделить блоки перед 
печатью.  

6 Введите значение припуска на шов  
     (Seam Allowance).
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 Контур, обведенный по припуску на шов, 

является линией раскроя, и он не 
соответствует контуру лоскута или линии 
стежки. 

                            Припуск на шов: 0.25" 

 
Припуск на шов: 1.0" 

 
7 Проставьте флажок в окошке Print Guide  для 

первой страницы, чтобы распечатать 
контурную схему всего квилта с номером 
каждого элемента, которые будут напечатаны 
на следующих страницах. Этот же номер 
появится около элемента, который будет 
напечатан отдельно. 

 
Совет: Для перехода от страницы к странице 
нажимайте кнопки Next Page и Previous Page.  

8 Нажмите кнопку Print. 
 
Печать форм аппликации 
 
Используйте функцию 
Print Appliqué для 
печати контура форм 
аппликации в квилте, 
который может быть 
использована как 
шаблон или как схема 
для сборки.  При 
выборе опции Print 
Guide номера, 
печатаемые в каждой 
аппликации, помещаются внутри изображения 
этой аппликации или снаружи – с линией, 
соединяющей номер с контуром формы. Если две 
аппликации имеют идентичную форму, то им 
присваивается один и тот же номер и они 
печатаются один раз. При распознавании 
одинаковых форм игнорируется поворот формы, 
но не перевод в зеркальное отображение, 
перекос или изменение размера. Аппликация 
может быть использована в квилте одним из двух 
способов: 
◄ нормальным: припуска на шов не требуется; 
◄ с подвернутыми краями: необходимо 

добавить припуск на шов. 
 

 
Используйте этот метод для печати форм 
аппликаций, созданные с использованием 
инструментов рисования аппликаций. См. раздел 
Печать конструкции блоков пэчворка для печати 
блоков, которые включают аппликацию как часть 
блока.  
 
Как печатать формы аппликации 
1 Нажмите кнопку Print Preview (Предварительный 

просмотр). 

 
 Откроется диалоговое окно Print Preview. 

 
2 Выберите Appliqué. 
3 Нажмите кнопку Options. 

Откроется диалоговое окно Print Options- Appliqué 
(Опции печати аппликаций). 

 
4 Выберите, нужно ли печатать в натуральную 

величину или назначьте число блоков на одной 
странице. 

5 Выберите опции печати: 
◄ Опция All: печатаются все формы 

аппликации. 
◄ Опция Selected: печатаются только 

выбранные формы аппликации. 
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Совет: Не забудьте выделить формы аппликации 
перед печатью. 
 
  

 
Все 
аппликации 
 
 
 
 
 
 
 

 
 
 
Одна 
выбранная  
аппликация  
 
 
 
 
 
 
6 Введите величину припуска на шов:  

◄ нормальная аппликация: 0  
◄ с подвернутыми краями: обычно 0.25". 

 
Совет: Для перехода от страницы к странице 
нажимайте кнопки Next Page и Previous Page. 

7 Нажмите кнопку Print. 
 
Распечатка всего квилта 
 
Используйте команду Print 
Whole Quilt для печати 
всего квилта с блоками 
и/или вышивкой и/или 
аппликацией.  
 
 
 
 
 
Как распечатать весь квилт 
1 Нажмите кнопку Print Preview.  
 Откроется диалоговое окно Print Preview. 

 
 
2  Выберите Whole Quilt (Весь квилт). 
3 Нажмите кнопку Options. 

Откроется диалоговое окно Print Options- 
Appliqué (Опции печати аппликаций). 

 
 

4 Выберите, нужно ли печатать в натуральную 
величину или назначьте масштабный 
коэффициент. 

5 Выберите, какие детали квилта вы хотите  
      напечатать:  

◄ Blocks (Блоки) 
◄ Appliqué (Аппликация) 

◄ Embroidery (Вышивка) 
 
                                   выбраны все опции 

 
        только квилт и блоки 
 
только квилт и аппликация 

 
        только квилт и вышивка 
 

Совет: Для перехода от страницы к странице 
нажимайте кнопки Next Page и Previous Page.  

6 Нажмите кнопку Print. 
 
Распечатка данных о расходе ткани 
 
Используйте команду 
Yardage для расчета и 
распечатки списка 
используемых тканей с 
указанием их расхода на 
основе ширины ткани и 
назначенной величины 
припуска на шов. Список 
начинается тканью с 
наибольшим расходом и 
заканчивается  тканью с наименьшим расходом. 
 
Как распечатать данные о расходе ткани 
1  Нажмите кнопку Print Preview (Предварительный 
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просмотр). 
 Откроется диалоговое окно Print Preview.  
2 Выберите Yardage 

 

 
3 Нажмите кнопку Options. 
 Откроется диалоговое окно Print 
Options-Yardage (Опции печати расхода ткани). 

     
 
4  Введите ширину ткани (Fabric width). 
5  Введите значение припуска на шов (Seam 

Allowance). 
 

Примечание: Один и тот же припуск на шов 
применяется ко всем лоскутам пэчворка и 
аппликациям. 

6 Проставьте флажок в окошке Print Details 

(Печатать подробности) для печати 
дополнительной информации под каждой 
тканью.  
При выбранной опции Print Details 
показывается контур требуемой ширины и 
длины ткани с каждым лоскутом пэчворка и 
объектом аппликации. 

 
Без опции Print Details:  

 
 
С опцией Print Details:  

 
 

Совет: Для перехода от страницы к странице 
нажимайте кнопки Next Page и Previous Page.  

7 Нажмите кнопку Print. 
 
Как печатать инструкции по вырезке 
 
С помощью опции  Rotary Cutting 
Instructions вы можете печатать инструкции 
по вырезкам ваших блоков. См. также раздел 

Создание блоков пэчворка.  

Примечание: не все пэтчи млжно 
вырезать, а только те, что состоят из простых 
форм с 3-мя или 4-мя сторонами.  Из-за этого в 
готовой инструкции по вырезке могут 
отображаться не все пэтчи. 

 
Чтобы распечатать инструкции по 
вырезке 

 
1 Нажать кнопку Print Preview. Откроется 

диалоговое окно Print Preview 
(предварительный просмотр распечатки). 

 

 
 
2 Выбрать опцию Rotary Cutting 

Instructions. 
 
3 Нажать Options. 

Откроется окно  Print Options-Rotary 
Cutting. 
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4 Выберите диапазон печати (print range), 

Или все (all), или выбор (selection). 

All: будут распечатаны все блоки. 

Selection: будут распечатаны только 
выбранные блоки. Выбрать вы их должны 
были заранее. 
 
5 Выберите  Припуски (Seam Allowance). 
Внешняя линия припуска называется линией 
среза и не соответствует контурам вышивки или 
квилта. 
. 
6 Поставьте галочку в окошке Print Guide 

(общий вид) чтобы распечатать  общий вид 

квилта. На общем виде указаны номера 

элементов, которые будут распечатаны на 
следующих страницах. Те-же номера 
указываются на тех-же элементах при их 
отдельной печати.  
 
Совет Чтобы просмотреть все страницы 
распечатки используйте кнопки  Next Page 

(следующая страница) и Previous Page 
(предыдущая страница). 
 
7 Нажмите OK. 

В окне предварительного просмотра будут 
отображены выбранные блоки. 
 

 
8 Нажмите кнопку Print (печать) и 

распечатайте диаграмму вырезки.
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ГЛАВА 3 
 

РЕДАКТИРОВАНИЕ В ПРОГРАММЕ 

BERNINA QUILTER 
------------------------------------------- 

 
 

 
 
 

BERNINA Quilter предоставляет технические средства для 
вставки рисунков и добавления  аппликаций или вышивок к 
квилту. BERNINA Quilter также позволяет копировать и 
вставлять, а также группировать и разгруппировать 
объекты и блоки пэчворка. Вы можете также редактировать 
проекты квилтов, включая перемещение, вращение и 
зеркальное отображение блоков пэчворка. 
В этом разделе дается подробная информация о функциях 
редактирования программы BERNINA Quilter. 

 
 
 
 
 
Добавление аппликаций к 
квилту 
 

 Используйте инструмент Rectangular 
Appliquè (панель Edit) для создания 
прямоугольных аппликаций. 
 
Используйте инструмент Draw Appliquè 
(панель Edit) для создания аппликаций 
произвольной формы. 
 
Используйте инструмент Circular Appliquè 
(панель Edit) для создания овальных 
аппликаций. 
 
Используйте инструмент Reshape Appliquè 
(панель Edit) для изменения формы 

аппликаций. 

 
 
Аппликация представляет собой одиночный 
кусок ткани, нашиваемый на квилт. Имеются три 
типа аппликаций: прямоугольные, овальные или 
произвольной формы. Аппликация произвольной 
формы может иметь сложные контуры.  

 
BERNINA Quilter 
предоставляет 
технические средства 
для добавления 
прямоугольников или 
окружностей, а также 
"замкнутых" 
произвольных форм. 
Эти аппликации 
являются только 
лоскутами ткани. 
Функция Auto Appliquè в 
программе ПО  BERNINA позволяет создавать 
вышитые аппликации.  
 
Примечание: Для создания аппликаций вы 
можете использовать растровые изображения в 
качестве трафарета. См. Оцифровывание с 
оригиналом в Руководстве пользователя. 
 
Рисование прямоугольных 
аппликаций 

 
 Используйте инструмент Rectangular 

Appliqué (панель Edit) для создания 
прямоугольных аппликаций. 
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Инструмент Rectangular Appliqué 
(Прямоугольная аппликация.) позволяет быстро 
оцифровывать аппликации в форме 
прямоугольника или квадрата. 
 
Как рисовать прямоугольную 
аппликацию 

1 Щелкните по значку Rectangular Appliqué. 
2 Оцифруйте один или несколько краев, как в 

ПО  BERNINA, наметив начало 
прямоугольника, а затем его углы. 

 
 Совет: Нажмите Alt и наметьте углы, чтобы 

оцифровать квадрат. 
3 Щелкните мышью, чтобы закрыть контур. 

    
 Совет: Изменяйте форму аппликации, 

используя инструмент Reshape Appliqué 
(Изменение формы аппликации). Этот 
инструмент используется таким же образом, 
как инструмент Reshape в ПО BERNINA. См. 
Изменение формы объектов с 
использованием контрольных точек в 
Руководстве пользователя 

 
Рисование аппликаций 
произвольной формы 

 
 Используйте инструмент Draw Appliqué 
(панель Edit) для создания аппликаций 

произвольной формы. 

 
Вы можете создавать произвольной формы 
контуры или обрамления, используя инструмент 
Draw Appliqué (Рисование аппликации). 
 
Как рисовать аппликации произвольной 
формы 

1 Щелкните по значку Draw Appliqué. 
2 Щелкните для создания точек на первом 

контуре. 
3 Щелкните, чтобы закрыть контур. 
4 Для создания отверстий в аппликации 

щелкните, чтобы наметить точки следующего 
контура.  Все контуры после первого 
являются отверстиями в аппликации. 

5 После оцифровывания последнего контура 
нажмите Enter еще раз, чтобы завершить 
создание аппликации.  

 Если цвет ткани выбран в библиотеке 
(Library), аппликация заливается этим 
цветом.  Если ткань не выбрана, аппликация 
заливается белым цветом. Добавьте 
требуемый цвет аппликации. 

 

     
Намеченные базисные точки. 

 
 Добавьте цвета или ткани, как это делается с 

блоками. Подробнее см. в разделе 
Добавление тканей к квилту. 

 
Рисование аппликаций в форме 
окружности 

 
 Используйте инструмент Oval Appliqué 
(панель Edit) для создания овальных 

аппликаций. 

 
Инструмент Oval Appliqué (Овальная 
аппликация.) позволяет быстро оцифровывать 
аппликации в форме окружности. 
 

Как рисовать аппликацию в форме 
окружности 

1 Щелкните по значку Oval Appliqué. 
2 Оцифруйте одну или несколько точек, как в 

ПО BERNINA, наметив центр, а затем точку 
на окружности. 

 
◄ Если вам нужна окружность, нажмите 

Enter.  
◄ Если вам нужен эллипс, наметьте третью 

базисную точку и нажмите Enter. 

    
 

Изменение формы аппликации 
 
 Используйте инструмент Reshape Appliqué 
(панель Edit) для установки контрольных 

точек выбранных объектов аппликации. 

 
Вы можете изменять форму аппликации, выбрав 
его инструментом Reshape Appliqué (Изменение 
формы аппликации) и перемещая, добавляя или 
удаляя контрольные точки на контуре. Для 
некоторых аппликаций вы можете также 
заменять угловые контрольные точки на 
контрольные точки кривых. 
 
Изменение формы аппликаций с 
использованием контрольных точек 

 
 Используйте инструмент Reshape Appliqué 
(панель Design) для отображения на экране 

контрольных точек выбранных 
аппликаций. 
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Изменяйте форму объектов аппликации, 
выбирая их инструментом Reshape Appliqué 

(Изменение формы аппликации) и манипулируя 
появившимися контрольными точками. 
 
Как изменять формы объектов 
аппликации с использованием 
контрольных точек 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué (Изменение 

формы аппликации). 
 Вокруг объекта появятся контрольные точки. 
 

     
угловая контрольная точка 
 
 
контрольная точка кривой 
 
 
 
 

3 Измените контур путем добавления, 
удаления или перемещения контрольных 
точек в зависимости от типа объекта и 
требуемых изменений. 

4 Измените точки входа и выхода и угол 
стежков по своему желанию. 

5 Нажмите Enter, чтобы принять изменения. 
 
 Совет: Нажмите клавишу Esc, чтобы 

отменить выделение инструментом Reshape 
Appliqué. 

 
Выбор контрольных точек 
Контрольные точки могут быть выбраны 
индивидуально или совместно для изменения 
положения или модификации. 
 
Как выбирать контрольные точки 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué. 

◄ Щелкните, чтобы выбрать единичную 
контрольную точку. 

 
 
 
 
 
 
 

◄ Удерживая клавишу Ctrl, щелкните, 
чтобы выбрать несколько контрольных 
точек.  

 

       
 

◄ Щелкните и обведите ограничивающий 
прямоугольник вокруг группы 
контрольных точек, чтобы выбрать их. 

    
 
Перемещение контрольных точек 
Вы можете перемещать контрольные точки, 
чтобы изменить форму контура. 
 
Как перемещать контрольные точки 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué. 

◄ Перетащите контрольную точку в новое 
положение. 

◄ Подобным же образом перетащите 
несколько точек в новое положение. 
Также перемешаются и многогранные 
объекты 

     
 
 
 
 
 
 
 

Добавление контрольных точек 
 
 Используйте инструмент Reshape Appliqué 
(панель Edit) для добавления контрольных 

точек. 

 
Вы можете добавлять контрольные точки на 
контуре объекта выбранным инструментом 
Reshape Appliqué. 
 
Примечание: Вы не можете добавлять 
контрольные точки к объектам аппликации, 
созданным инструментом Circle (Окружность). 
 
Как добавлять контрольные точки 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué. 
3 Установите указатель мыши в том месте, где 

вы хотите добавить контрольную точку. 
4 Щелкните, чтобы добавить контрольную 

точку: 
◄ левой кнопкой, чтобы добавить угловую 

точку: 
◄ правой кнопкой, чтобы добавить точку 

кривой. 
 
 

 Щелчок правой 
кнопкой мыши 
 
 
 
 
 
Щелчок левой 
кнопкой мыши 
 

 
 

5 Определите положение новой контрольной 
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точки, перемещая ее по контуру объекта. 
 
Изменение контрольных точек 
Изменение формы объекта выполняется путем 
преобразования угловых контрольных точек в 
точки кривой и наоборот. 
 
Примечание: Вы не можете изменять 
контрольные точки объектов аппликации, 
созданным инструментом Circle (Окружность). 
См. также Изменение формы объектов 
аппликации. 
 
Как изменять контрольные точки 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué. 
3 Выберите контрольную точку. 
4 Нажмите клавишу пробела. 

     
 
Удаление контрольных точек 
Удаляйте нежелательные контрольные точки 
для изменения контура 
 
Как удалять контрольные точки 

1 Выделите объект. 
2 Нажмите кнопку Reshape Appliqué. 
3 Выберите контрольную точку или точки. 
4 Нажмите клавишу Delete. 

    
Примечание: Если у объекта имеется только 
две контрольных точки, то при удалении 
одной из них удаляется весь объект. 

 
Изменение формы объектов 
аппликации в виде окружности 
 

 Используйте инструмент Reshape Appliqué 
(панель Edit) для изменения формы 
объектов аппликации в виде окружности. 

 
Для объектов аппликации, созданных 
инструментом Circle (Окружность), изменение 
формы производится только контрольными 
точками. В таких объектах аппликации вы не 

можете добавлять, изменять или удалять 
контрольные точки. Объекты аппликации в 
форме окружности можно преобразовывать из 
окружности в овал инструментом Reshape 
Appliqué. Объекты аппликации в форме 
окружности имеют две контрольные точки 
изменения формы (используемые для 
изменения радиуса и ориентации объекта), 
центральную точку (используемую для 
изменения положения) и точку входа стежка. 
 
                                                                       
    
                           
контрольная 
точка 
 
точка центра  
                                                                        
контрольная 
точка 
 
 

Как изменять форму объектов 
аппликации в виде окружности 

1 Выберите объект окружности. 
2 Нажмите кнопку Reshape Appliqué. 
 

Совет: Для перемещения окружности 
щелкните по контрольной точке в центре 
окружности и перетащите ее в новое 
положение. 

3 Щелкните по контрольной точке на контуре 
окружности и перетащите ее для изменения 
формы контура. 
◄ Для изменения формы без изменения 

ориентации используйте верхнюю 
контрольную точку. 

 
 
 
 
 
    

контрольная точка изменения формы  
 

◄ Для изменения формы и вращения 
объекта вокруг центральной точки 
используйте нижнюю контрольную точку. 

 
 
 
 
 

контрольная точка изменения формы  
 
 
4 Нажмите Enter. 
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Включение вышивки в проекты 
квилта 
 
Проекты вышивки можно открывать и 
редактировать в окне BERNINA Quilter 
Embroidery. Вы можете также создать новый 
проект вышивки "на лету" для добавления к 
квилту. 
 
Добавление вышивки к квилту 
 

 Используйте инструмент Embroidery 
Window (панель Edit) для добавления 
вышивки к проектам квилта.  

 
Добавьте предварительно оцифрованный проект 
или новый проект вышивки в окне BERNINA 
Quilter Embroidery.  
Проект квилта может содержать больше одного 
проекта вышивки. 

 
 
Примечание: Проекты вышивки на квилте нужно 
открывать и вышивать в программе BERNINA. 
Вы не можете вышивать проекты вышивки из 
программы BERNINA Quilter. 
 

Как добавлять вышивку к квилту 

1 Откройте проект квилта. 
2 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 

 
 
3 В окне проекта вышивки выберите File (Файл) 

> Insert Design (Вставить проект). 
4 Выберите проект и нажмите OK. 
5 Проведите требуемые изменения. 

Все изменения можно увидеть в окне квилта. 
    

 
6 Выберите File (Файл) > Save and Return 

(Сохранить и вернуться). 
 Окно Embroidery Window закроется. 
 
 Совет: Используйте команду File (Файл) > 

Save As (Сохранить как) для сохранения 
копии оригинального проекта. 

7 Выделите и переместите проект вышивки в 
требуемое положение. 

   

 
 
 
Создание нового проекта вышивки 
 
 Используйте инструмент Embroidery Window 

(панель Edit) для добавления вышивки к 
проектам квилта.  

 
Создайте новый 
проект вышивки "на 
лету" для добавления 
к квилту. При 
создании проекта 
вышивки объекты  со 
стежками и цветом 
показываются в окне 
BERNINA Quilter. 
Каждый проект 
вышивки на квилте 
открывается для 
редактирования в 
собственном окне 
Embroidery Window. 
Объекты, оцифрованные в окне Embroidery 
Window, показываются в окне BERNINA Quilter с 

использованием той же средней 
базисной точки. 
 

Как создать новый проект вышивки 

1 Откройте проект квилта. 
2 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 



Глава 3: Редактирование в программе BERNINA Quilter  

BERNINA
®
  Программа Quilter 33

 
3 Используйте инструменты оцифровывания 

для создания проекта вышивки, как в ПО 
BERNINA. 

4 Когда проект будет завершен, выберите 
команду File > Save and Return. 
 

Файл проекта вышивки будет сохранен с 
программой BERNINA Quilter, и открывается при 
открытии файла BERNINA Quilter. 
 
 

  
Вставленный объект 

 
Редактирование проектов вышивки в 
программе Quilter 
 

 Используйте инструмент Embroidery 
Window (панель Edit) для добавления 
вышивки в проекты квилта.  

 
Вы можете редактировать проекты вышивки в 
программе Quilter. Любые сделанные вами 
изменения показываются во время работы. 
 
Примечание: Вы не сможете открыть окно 
Embroidery Window, если вы выбрали несколько 
проектов или сгруппированные проекты. 
     
 
Как редактировать проект вышивки в 
программе Quilter 

1 Откройте проект квилта. 

2 Выделите объект вышивки. 

 
 

Выделенный объект  
 
 
 
 
 
 
 
 

3 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 
5 После редактирования выберите команду File 

(Файл) > Save and Return. 
Файл вышивки сохраняется в программе 
Quilter и образует часть файла, сохраненного 
на диске. 

 
Объект, 

редактированный  
в ПО BERNINA  

 
 

Редактирование блоков и 
объектов 
 
Для редактирования фрагмента проекта, вы 
должны вначале его выделить. Программа 
BERNINA Quilter предусматривает несколько 
способов выделения блоков. Имеется также 
возможность блокировать блоки в комплексных 
проектах, так чтобы их нельзя было случайно 
выделить и переместить. 
Вы можете сгруппировать или разгруппировать 
любую комбинацию блоков, рисунков, 
аппликаций и проектов вышивки тем же 
способом, что и в ПО  BERNINA. Специальный 
инструмент Regroup (Перегруппировать) 
позволяет снова объединить в группу все 
предварительно сгруппированные, а затем 
разгруппированные объекты. См. раздел 
Группировка и разгруппировка объектов в 
Руководстве пользователя. 
 
Примечание: Команда Regroup не работает, 
если объект был редактирован после 
разгруппирования. 
Вышивка, объект аппликации или рисунок могут 
быть выровнены по любому блоку путем 
выделения объекта и блока и использованием 
инструментов выравнивания, как в ПО  
BERNINA. Инструменты расположения по слоям 
помогут правильно расположить по слоям 
аппликации и объектов вышивки. См. раздел 
Выравнивание объектов в Руководстве 
пользователя. 
 
Выбор блоков инструментом Select  

 
 Используйте инструмент Select (панель Edit) 
для выбора блоков или объектов. 

 
Инструмент Select (Выбор) работает таким же 
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образом, как в ПО  BERNINA. Различие 
заключается в том, что в программе BERNINA 
Quilter вы работаете с блоками или 
фрагментами, а не с объектами проекта. 
 
Совет: Нажмите Ctrl + A для выделения всех 
объектов аппликации.  
 
Как выбрать блок инструментом Select  

◄ Выбранным инструментом Select щелкните 
по блоку.  

 
         Выделен один блок 

 
Выделено несколько блоков 

 
Совет: Удерживайте нажатой клавишу Ctrl для 
выбора нескольких блоков. 

 
Выбор блоков инструментом 
Eyedropper 

 
 Используйте инструмент Eyedropper (панель 
Edit) для выбора блоков или тканей. 

 
Используйте инструмент Eyedropper (Пипетка) 
для выбора блока пэчворка или ткани, который 
уже был использован в квилте или сохранен в 
Палитре тканей (Fabric Palette). Используйте 
инструмент Paintbrush (Кисть) для добавления 
блока пэчворка или ткани к квилту. 
 
Как выбрать блок инструментом 
Eyedropper 

1 Щелкните по значку Eyedropper (Пипетка). 
2 Выберите блок пэчворка или ткань. 

◄ Нажмите кнопку Blocks (Блоки) для 
блоков пэчворка.  

◄ Нажмите кнопку Colors для одноцветных 
тканей.  

◄ Нажмите кнопку Fabrics для набивных 
тканей.  

 

3 Выберите цвет, ткань или блок пэчворка из 
квилта или одну из используемых палитр 
(Palettes Used). 

 Для предварительного просмотра служит 
панель Library Preview (Предварительный 
просмотр библиотеки). 

 
 
4 Щелкните по значку Paintbrush (Кисть) для 
добавления блока или ткани к квилту. 
  
 

 
 

Кистью добавляется  
выбранный блок. 

 
 
Блокирование фрагментов квилта 

 
Используйте инструмент Lock Quilt (панель 
Lock), чтобы заблокировать весь квилт.  
 
Используйте инструмент Lock Appliquè 
(панель Lock), чтобы заблокировать формы 
аппликации.  
 
Используйте инструмент Lock Embroidery 
(панель Lock), чтобы заблокировать проект 
вышивки.  

 
В сложных квилтах не исключена возможность 
ошибочного выделения и перемещения частей 
квилта. Блокирование квилта позволяет 
работать с аппликацией или вышивкой, не 
опасаясь случайного выделения и изменения 
квилта. Блоки, межблоковые полоски и окантовки 
не могут быть случайно выделены и 
перемещены. 
 
Как блокировать фрагменты квилта 
◄ Щелкните по значку Lock Quilt 

(Заблокировать квилт).  
 

Квилт не заблокирован,   Квилт заблокирован,  
выделен блок     легко выделяется аппликация 

Выбранные  
цвета 
 
Пипеткой  
переносится  
выбранный цвет 
 
 
 
Выбранные  
блоки 
 
 
Пипеткой  
переносится  
выбранный блок 
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◄ Щелкните по значку Lock Quilt еще раз для 

разблокирования квилта. 
 
Щелкните по значку Lock Appliquè 
(Заблокировать аппликацию). 
 
Аппликация не заблокирована,         Аппликация заблокирована,  
по ошибке изменен цвет    облегчено редактирование  

блоков 

      
◄ Щелкните по значку Lock Appliquè еще раз 

для разблокирования аппликации. 
◄ Выберите Lock Embroidery (Заблокировать 

вышивку). 
 

Вышивка заблокирована  Вышивка не заблокирована 

     
◄ Щелкните по значку Lock Embroidery еще раз 

для разблокирования вышивки. 
 

Перегруппировка объектов 
 
Щелкните по значку Group (панель Arrange), 
чтобы сгруппировать выделенные объекты. 
 
Щелкните по значку Ungroup (панель 
Arrange), чтобы разгруппировать 
выделенные объекты. 
 
Щелкните по значку Regroup (панель 
Arrange), чтобы снова объединить в группу 
предварительно разгруппированные 

объекты. 

 
Вы можете сгруппировать или разгруппировать 
любую комбинацию блоков, рисунков, 
аппликаций и проектов вышивки тем же 
способом, что и в ПО BERNINA. См. раздел 
Группировка и разгруппировка объектов в 
Руководстве пользователя. 

 
Используйте команду Regroup 
(Перегруппировать) для повторного 
объединения в группу всех предварительно 
сгруппированных, а затем разгруппированных 
объектов. Например, если у вас имеются 
некоторые объекты аппликации, которые вы 
объединили в группу, а затем разгруппировали 
для редактирования, то вы можете 
сгруппировать их опять без повторного 
выделения. Эта команда работает только в том 
случае, если в группу не были включены новые 
объекты. 
 
Как перегруппировать объекты 

1 Выберите сгруппированный объект и 
разгруппируйте его. 
2 При необходимости отредактируйте объекты, 

а затем: 
◄ выберите команду Arrange > Regroup, 

или 
◄ щелкните по значку Regroup на панели 

Arrange, или 
◄ нажмите Ctrl + R. 

Объекты будут снова объединены в группу. 
    

 
Сгруппированы      Объекты отредактированы  
оранжевые аппликации    и снова объединены в группу. 

  
Размещение объектов 

Используйте инструмент Bring to Front 
(панель Arrange), чтобы перевести 
выбранный объект на передний план.  
 
Используйте инструмент Bring Forward 
(панель Arrange), чтобы перевести 
выбранный объект на один слой вперед.  
 
Используйте инструмент Send to Back 
(панель Arrange), чтобы отослать 
выбранный объект на задний план.  
 
Используйте инструмент Send Backwards 
(панель Arrange), чтобы перевести 
выбранный объект на один слой назад.  

 
При использовании вышивок или объектов 
аппликации важно расположить их в правильном 
порядке, чтобы. например, вышивка находилась 
сверху, а служащая фоном аппликация – снизу.  
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Перемещайте объекты непосредственно на 
задний или передний план или же постепенно на 
один слой назад или вперед. Передним планом 
является верхний слой, задним планом – самый 
нижний слой. 
 
Совет: Используйте инструменты расположения 
по слоям для удержания рисунка на переднем 
плане во время калькирования объектов 
аппликации. 
 
Как размещать объекты 
 

1 Выберите вышивку, объект аппликации или 
рисунок. 

 
Объект, подлежащий 
перемещению 
 
 
 

 
2 Щелкните по одному из инструментов 
послойного размещения по слоям: 
- Bring to Front (Перевести на передний план) 

 
 
 
 
Объект переведен на 
передний план 
 
 

 
◄ Move Forwards (Перевести на один слой 

вперед) 
 
 
Объект перемещен на один 
слой вперед 
 
 
 

◄ Move Backwards (Перевести на один слой 
назад) 

 
 
Объект перемещен на 
один слой назад 
 
 
 

 
◄ Send to Back (Отослать на задний план) 
 

 
 
Объект переведен на задний 
план 
 
 
 

 

 
Совет: Вышивка, объект аппликации или 
рисунок могут быть выровнены по любому блоку 
путем выделения объекта и блока и 
использованием инструментов выравнивания, 
как в ПО BERNINA. См. раздел Выравнивание 
объектов в Руководстве пользователя. 

Дублирование блоков и 
объектов 
Вы можете копировать, вырезать и вставлять 
выбранные блоки, аппликации или вышивки в 
любое время. В программе BERNINA Quilter вы 
можете работать с блоками пэчворка и тканями, 
а также с объектами аппликации и вышивки. 
 
Копирование, вырезание и вставка 
инструментом Select  
 

Используйте инструмент Select (панель 
Edit) для выбора блоков или объектов. 
 
 
Используйте инструмент Copy (панель 
Standard), чтобы копировать выделенные 
блоки в буфер обмена. 
 
 
 

Используйте инструмент Cut (панель 
Standard), чтобы вырезать выделенные 
блоки в буфер обмена. 
 
 
 
 

Используйте инструмент Paste (панель 
Standard), чтобы вставить скопированные 
блоки из буфера обмена. 
 

 

Используйте инструмент Select (Выбор) для 
копирования и вставки блоков, аппликации или 
вышивки и инструмент Paintbrush (Кисть) для 
копирования и вставки тканей. 
 
Примечание: Если блок вставляется из одного 
квилта в другой, а у этих квилтов разные 
размеры блоков, то вставляемый блок будет 
увеличен или уменьшен для подгонки к новому 
квилту. 
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Как копировать, вырезать и вставлять 
инструментом Select  

1 Щелкните по инструменту Select. 
2 Выберите блок, вышивку или аппликацию, 

которую нужно вырезать или скопировать, и 
затем  выполните одну из следующих 
операций: 
◄ Нажмите кнопку Cut (Вырезать). 
◄ Выберите Edit > Copy. 
◄ Нажмите кнопку Copy (Копировать). 
◄ Нажмите Ctrl + R. 
◄ Щелкните правой кнопкой мыши по 

объекту и выберите Copy из 
всплывающего меню. 

    Выберите блоки для копирования 

 
Оригинальный квилт 
 

3 Щелкните по месту, куда нужно вставить 
блок, и затем  выполните одну из следующих 
операций: 
◄ Выберите Edit > Paste. 
◄ Нажмите кнопку Paste (Вставить). 
◄ Нажмите Ctrl + V. 
◄ Щелкните правой кнопкой мыши по 

объекту и выберите Paste из 
всплывающего меню. 

    Блоки, вставленные в новое положение 

     
Выберите, куда нужно вставить блоки 

Добавление блоков и тканей 
инструментом Paintbrush 

 
Используйте инструмент Paintbrush (меню 
Edit) для добавления тканей к квилту.  

 

Используйте инструмент Paintbrush (Кисть) для 
добавления блоков пэчворка к квилту из 
библиотеки. 
 
Примечание: Блоки пэчворка не могут быть 
добавлены к межблоковым полоскам, 
соединительных квадратам или частям 
окантовки, так как они не выполнены в стиле 
блоков. 
 
Как добавлять блоки и ткани 
инструментом Paintbrush 

1 Нажмите кнопку Paintbrush (Кисть). 
2 Выберите для добавления блок пэчворка или 
ткань: 

◄ Нажмите кнопку Blocks для блоков 
пэчворка.  

◄ Нажмите кнопку Colors для 
одноцветных тканей.  

◄ Нажмите кнопку Fabrics для набивных 
тканей.  

3 Выберите на квилте блок пэчворка или ткань 
и щелкните правой кнопкой мыши для 
копирования. 

 
Щелчок правой кнопкой мыши 

       
Библиотека блоков     Библиотека тканей 
Щелкните правой      Щелкните правой  
кнопкой по библиотеке   кнопкой по библиотеке 
пэчворка       лоскутов пэчворка 

 

4 Переместите указатель мыши так, чтобы он 
находился внутри блока на квилте, затем 
щелкните для помещения блока пэчворка или 
ткани. 

        
  Щелкните по блокам    Щелкните по фрагментам  

  для размещения    для размещения 
          

 Совет: Для копирования блока или ткани во 
весь квилт переместите указатель мыши 
внутрь блока, затем нажмите клавишу Ctrl и 
щелкните, чтобы скопировать проект в квилт. 

Преобразование блоков и 

объектов 
 
Программа BERNINA Quilter позволяет 
проводить различные преобразования 
выбранных блоков. Вы можете перемещать их, 
поворачивать по часовой стрелке или против 
часовой стрелки. Вы можете также зеркально 
отображать блоки, переворачивая их по 
горизонтали или по вертикали. 
 
Перемещение блоков и объектов 
Вы можете перемещать блоки в любое время. 
Рисунки, вышивки или объекты аппликации 
можно перемещать таким же образом. 
 
Как перемещать блок или объект  

1 Щелкните по инструменту Select. 
2 Выберите блок или объект для перемещения. 
 
3 Перетащите его мышью в новое положение. 
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Выбранный блок   перемещен в новое  

                                                    положение 
 

◄ При перетаскивании мышью нажмите 
клавишу Ctrl, чтобы переместить объект 
вверх или вниз. 

        
Выбранная аппликация  Клавиша Ctrl и  
                                                   перетаскивание  

в новое положение 
 

◄ При перетаскивании мышью нажмите 
клавишу Alt, чтобы скопировать объект в 
новое положение.  

 
Выбранная аппликация       Клавиша Alt и перетаскивание  
                                                               для копирования 

 
◄ При перетаскивании мышью нажмите 

клавиши Ctrl + Alt, чтобы скопировать 
объект в новое положение вверх или вниз.  

 
            Выбранная аппликация        Клавиши Ctrl+Alt и  
                                                   перетаскивание для копирования в 
                                                                 нижнее положение 

 
Вращение блоков и объектов 

 
Используйте инструмент Rotate 90°CCW/CW 
(панель Edit) для вращения выбранных 

блоков. Щелчок левой кнопкой мыши – 
поворот против часовой стрелки. Щелчок 
правой кнопкой – поворот по часовой 
стрелке. 

 
Вы можете поворачивать блоки или объекты по 
часовой стрелке или против часовой стрелки. 
Если выбрано несколько блоков, каждый из них 
вращается в собственном положении. 

 
Каждый выбранный рисунок, вышивку или 
аппликацию можно свободно поворачивать 
путем перетаскивания маркеров вращения. 
 
Совет: Удерживайте нажатой клавишу Alt во 
время поворота объекта с использованием 
маркеров вращения, чтобы создать повернутую 
копию оригинала.  
 
Как вращать блок или объект  

1 Выберите блок или объект для вращения. 
 Подробнее см. в разделе Редактирование  

      блоков и объектов. 
2 Щелкните по значку Rotate 90°CCW/CW . 

◄ Щелчок правой кнопкой – поворот на 90° 
по часовой стрелке. 

◄ Щелчок левой кнопкой – поворот на 90° 
против часовой стрелки. 

    

 
Выбранный блок   Повернутый блок 

 
Совет: Вы можете также вращать объекты 
перетаскиванием мышью. См. также раздел 
Вращение объектов перетаскиванием 
мышью. 

 
Перевод в зеркальное отображение 
блоков и объектов 
 

Щелкните по инструменту Mirror Horizontal 
(панель Edit) для переворачивания 
выбранных блоков по горизонтали. 
 
Щелкните по инструменту Mirror Vertical для 
переворачивания выбранных блоков по 
вертикали. 

 
Вы можете зеркально отображать блоки, 
переворачивая их по горизонтали или по 
вертикали. Если выбрано несколько объектов, 
они зеркально переворачиваются относительно 
центра всей выборки. 
   

 
Если выбран одиночный блок, то он зеркально 
переворачивается относительно своего центра. 
Если выбрано несколько блоков, их проекты 
зеркально переворачиваются относительно их 
центров. 
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Как зеркально перевернуть блок или 
объект  

1 Выберите блок или объект для зеркального 
отображения. 

 Подробнее см. в разделе Редактирование 
блоков и объектов. 

2 Щелкните по значку Mirror Horizontal, чтобы 
перевернуть объект по горизонтали, или 
Mirror Vertical,  чтобы перевернуть объект по 
вертикали. 

   

 
Переворот по вертикали   Копирование и  

переворачивание 
по горизонтали 

 
Перекос объектов 
Любой рисунок или аппликация может быть 
перекошен таким же образом, как объект в ПО 
BERNINA, за исключением того, что имеется в 
два раза маркеров перекоса. Вышивки могут 
быть перекошены в окне Embroidery Window. 
 
Как перекосить объект  

1 Дважды щелкните по рисунку или объекту 
аппликации. 

 

Появятся маркеры перекоса 
2 Перекосите объект путем перетаскивания 
маркеров перекоса. См. также раздел Перекос 
объектов перетаскиванием мышью. 
      
 
 
 
 
 
 
 
 

Совет: Удерживайте клавишу Alt при 
перекашивании объекта, чтобы скопировать и 
перекосить объект, оставив оригинал без 
изменений.  

 
 
Изменение размеров объектов 
 

Используйте инструмент Scale by 20% 
Down/Up (панель Design), чтобы изменить 
размеры аппликации или объектов 
вышивки. 

 
Размеры рисунка, вышивки или аппликации 
можно изменять перетаскиванием их маркеров 

изменения размера. Размеры любого 
выбранного рисунка, вышивки или аппликации 
можно изменить на 20 % от текущего значения 
инструментом Scale by 20% Down / Up таким же 
образом, как в ПО BERNINA. Если выбран 
объект вышивки, откроется окно Embroidery 
Window, когда вы щелкните по инструменту 
Scale by 20% Down/Up или начнете использовать 
маркеры изменения размера.  
 
Как изменить размер объект  

1 Выделите объект. 
2 Измените размер объекта: 

◄ Щелкните левой кнопкой по значку Scale 
by 20% Down/Up для уменьшения 
размера на 20 %. 

◄ Щелкните правой кнопкой по значку Scale 
by 20% Down/Up для увеличения размера 
на 20 %. 

 
Удаление блоков и объектов 
 
Вы можете удалить ткани из индивидуальных 
элементов пэчворка, используя "пустой блок". 
Блоки пэчворка могут быть удалены из квилта, 
используя "пустой блок" или кнопку Delete. 
Аппликация или объекты вышивки можно 
удалить из квилта кнопкой Delete. 
 
Удаление тканей с использованием 
"пустого блока" 
Ткани из индивидуальных элементов пэчворка 
можно удалить, используя "пустой блок". Этот 
прием полезно использовать в том случае, если 
нужно удалить подборку тканей с произвольным 
расположением в квилте. См. также Удаление 
объектов. 
 
Как удалять тканей с использованием 
"пустого блока" 

1 Выберите значок Colors или Fabrics. 
 

Внимание: Если выбрана кнопка Blocks, вы 
удалите блок пэчворка.  

2 В диалоговом окне Library нажмите кнопку 
Blank (Пустой). 

 Окно просмотра очистится. 

 
Выбран пустой блок 
 
3 Выделите одну или лоскутов пэчворка. 
 

Лоскут пэчворка будет очищен. 
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Оригинальный квилт    Нажата кнопка Colors  

 

Совет: Удерживайте нажатой клавишу Ctrl и 
затем щелкните по блоку или лоскуту для 
удаления из квилта.  
 
            Нажмите Ctrl для применения ко всем 

   
Оригинальный квилт    Нажата кнопка Colors  

 
 
Удаление блоков 
 
Блоки пэчворка могут быть удалены из квилта, 
используя "пустой блок" или кнопку Delete. Этот 
прием полезно использовать в том случае, если 
нужно удалить подборку блоков пэчворка с 
произвольным расположением в квилте. 
Подробнее см. в разделе Удаление тканей с 
использованием "пустого блока". 
 
Как удалить блок 

1 Щелкните по кнопке Select (Выбрать). 
2 Нажмите кнопку Blocks (Блоки). 
3 Выберите блок/и для удаления. 
4 Выполните одну из следующих операций: 

◄ Щелкните по окошку Blank (Пустой) в 
диалоговом окне Library. 

◄ Нажмите клавишу Delete. 
 

    
Оригинальный квилт    Выбрана кнопка Blocks  

 
Удаление объектов 
Аппликацию или объекты вышивки можно 
удалить из квилта с использованием клавиши 
Delete таким же образом, как в ПО BERNINA. 
 
Примечание: Используйте функцию Blank 

совместно с кнопкой Fabrics для удаления 
ткани из аппликации.  
 
Как удалить объект  

1 Щелкните по кнопке Select (Выбрать). 
2 Выберите объект/ы для удаления. 
3 Нажмите клавишу Delete. 
 Объекты удалены. 
 

Удаленные аппликации 

 
Ткани удалены из аппликации 
 

Совет: Используйте функцию Lock Quilt 
(Заблокировать квилт), чтобы  
предотвратить ошибочное выделение и 
удаление блоков пэчворка.  Подробнее см. в 
разделе Блокирование фрагментов квилта. 
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ГЛАВА 4 
 

ПРОГРАММА BERNINA QUILTER 

ДЛЯ ОПЫТНЫХ ПОЛЬЗОВАТЕЛЕЙ 
------------------------------------------- 
 
 
 
 
 
 

Программа BERNINA Quilter 
позволяет импортировать рисунки 
для использования в качестве 
узоров ткани. Из единичного 
образца ткани вы можете создать 
несколько различных образцов. 
Программа BERNINA Quilter 
предоставляет разные 
возможности управлять вашими 
узорчатыми тканями. Также 
имеется возможность создавать 
новые категории ваших блоков 
пэчворка, удалять их и 
перемещать блоки между 
категориями. 
В этом разделе дается подробная 
информация о более сложных функциях программы BERNINA Quilter, включая 
управление оригиналами и образцами ткани, изменение внешнего вида образцов 
ткани и управление блоками пэчворка. 

 

Модификация элементов 
мозаики образцов тканей 
 
Из одного образца ткани вы можете создать 
несколько различных образцов. Каждый образец 
может быть сохранен с отдельным именем и при 
необходимости в разных категориях. 
 

 
Выберите различные фрагменты для создания разных 
образцов ткани 

 
Увеличение масштаба изображения позволяет 
увидеть больше деталей или просмотреть 
изображение в фактическом размере. Фрагмент 
с элементом мозаики может быть изменен по 
размеру или перемещен для создания 
привлекательного образца вашей ткани. Можно 
также повернуть изображение для изменения 
внешнего вида. 
 
Выбор элементов мозаики ткани 
 

Используйте команду Select (диалоговое 
окно Tile Fabric) для выбора фрагмента 
образца ткани.  

 
Используйте диалоговое окно Tile Fabric, чтобы 
создать ткань с мозаичным узором по своему 
желанию. Вы можете выбрать и сохранить 
точный фрагмент ткани, который должен быть 
использован в качестве элемента мозаики. При 
выборе только маленького фрагмента ткани с 
использованием кадрирующего прямоугольника 
вы можете изменить вид образца ткани, так как 
только выбранный фрагмент располагается 
рядами и отображается в окне просмотра. 
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Как выбрать элемент мозаики ткани 

1 Выберите и дважды щелкните по узору в 
библиотеке. 

 
 
 
 
 
 
 
 
 
 
 
 
Выберите 
узор и 
дважды 
щелкните по 
нему. 
 
 
  
 
 
 
 
 
 
 
 

 
Откроется диалоговое окно Tile Fabric.  
 

 
 
2 Щелкните по кнопке Select (Выбор). 

 

 
3 Щелкните и обведите прямоугольник вокруг 

фрагмента, который должен быть отображен 
в образце ткани. 

 
 
 
 
 
 
 
 
 
 
Выбранный  
фрагмент 
 
 
 
 
 
 
 
 
 
 
 
Выбранный  
фрагмент 
 
 
 
 
 
 

Совет: Увеличьте масштаб изображения, 
чтобы было легче выбрать мелкий фрагмент. 
Подробнее см. в разделе Изменение 
масштаба изображения образцов ткани. 

4 Нажмите кнопку Save As (Сохранить как), 
чтобы сохранить образец и оставить без 
изменений оригинал.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Новый образец 
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 Примечание: Нажмите кнопку Save, чтобы 

заменить оригинальное изображение новым 
образцом.  

Изменение масштаба 
изображения образцов ткани 

 
Используйте инструмент Zoom 1:1 
(диалоговое окно Tile Fabric) для 
просмотра образца ткани в натуральную 
величину.  
 
Используйте инструмент Zoom In 
(диалоговое окно Tile Fabric) для 
увеличения изображения образца ткани. 
 
Используйте инструмент Zoom Out 
(диалоговое окно Tile Fabric) для 
уменьшения изображения образца ткани. 

 
Инструменты изменения масштаба изображения 
используются для просмотра образцов ткани в 
натуральном, увеличенном или уменьшенном 
размере.  Изменение масштаба изображения не 
изменяет образец в окне просмотра. 
 
Как изменять масштаб изображения 
образца ткани 

1 Выберите и дважды щелкните по узору в 
библиотеке. 

 Откроется диалоговое окно Tile Fabric. 
 

 
 
2 Щелкните по одному из значков изменения 

масштаба: 
 

 Zoom 1:1 для просмотра ткани в 
натуральную величину.  

 

 
 

◄ Zoom In 2x для увеличения  
масштаба в 2 раза.  

 
 

◄ Zoom Out 2X для уменьшения масштаба 
в 2 раза.  

 

 

Вращение образцов ткани 
 
Используйте инструмент Rotate Left 
(диалоговое окно Tile Fabric) для поворота 
образца ткани влево. 
 
Используйте инструмент Rotate Right 
(диалоговое окно Tile Fabric) для поворота 
образца ткани вправо. 

 
При использовании инструментов вращения 
образец ткани поворачивается на 90° вправо или 
влево. В окне просмотра никаких изменений не 
происходит. 
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Примечание: Поворачивается ткань, но не 
кадрирующий прямоугольник. 
Как поворачивать образец ткани 

1 Выберите и дважды щелкните по узору в 
библиотеке. 

 Откроется диалоговое окно Tile Fabric. 
   

 
2 Выберите при необходимости фрагмент. 
3 Щелкните по одному из значков вращения: 

◄ Rotate Left (Повернуть влево) 
◄ Rotate Right (Повернуть вправо) 

 

 
Образец повернут влево 

4 Нажмите кнопку Save As (Сохранить как), 
чтобы сохранить образец и оставить без 
изменений оригинальный образец.  

Точное изменение размеров 
элементов мозаики 
Если вам нужно точно определить размеры 
кадрирующего прямоугольника, введите его 
размеры. 

 
Как точно изменить размер элемента 
мозаики 

1 Выберите и дважды щелкните по узору в 
библиотеке. 

 Откроется диалоговое окно Tile Fabric. 
   

2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните и приблизительно обведите 

прямоугольник вокруг фрагмента, который 
должен быть отображен в образце ткани. 

 
 Совет: Увеличьте масштаб изображения, 

чтобы было легче выбрать мелкий фрагмент. 
Подробнее см. в разделе Изменение 
масштаба изображения образцов ткани. 

4 В поля Tile Height (Высота фрагмента) и Tile 

Width (Ширина фрагмента).введите 
размеры. 

 Измерения начинаются от верхнего левого 
угла предварительно очерченного 
прямоугольника. 
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Введите размеры 

5 Нажмите кнопку Save As (Сохранить 

как), чтобы сохранить образец и оставить 
без изменений оригинальный образец.  

 
Изменение размеров элементов 

мозаики инструментом Move / Edit 
Selection 

 
Используйте инструмент Move/Edit 
Selection (диалоговое окно Tile Fabric) для 
изменения размера образца ткани шагами 
по одному пикселю. 

 
Если вам нужно изменять размеры 
кадрирующего прямоугольника шагами по 
одному пикселю, используйте инструмент 
Move/Edit Selection (Перемещение/ Изменение 
выбора). Используйте этот метод, если нужно 
обрезать или расширить элементы мозаики на 
небольшую величину. 
 
Как изменять размеры элементов 
мозаики инструментом Move / Edit 
Selection 

1 Выберите и дважды щелкните по узору в 
библиотеке. 

 Откроется диалоговое окно Tile Fabric. 
2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните и обведите прямоугольник вокруг 

фрагмента, который должен быть 
использован в качестве элемента мозаики в 
образце ткани. 

 Совет: Увеличьте масштаб изображения, 
чтобы было легче выбрать мелкий фрагмент. 
Подробнее см. в разделе Изменение 
масштаба изображения образцов ткани. 

4 Выберите инструмент Move/Edit Select  
 

Выбран инструмент Move/Edit Selection  
 

 
Фрагмент, который должен быть удален 

 
5 Установите указатель мыши вблизи одной из 

сторон кадрирующего прямоугольника. 
◄ Поместите указатель мыши снаружи 

прямоугольника, чтобы увеличить размер 
элемента мозаики. 

◄ Поместите указатель мыши внутри 
прямоугольника, чтобы уменьшить 
размер элемента мозаики. 

 Указатель мыши приобретет форму стрелки 
Move / Edit Selection. 

 
 
 
 
 
 
 
 
Указатель мыши 
Move/Edit Selection 
 
 

 
6 Щелкайте внутри или снаружи контура 

прямоугольника до тех пор, пока не будут 
получены требуемые размеры. 
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 Примечание: В полях Tile Height (Высота 

фрагмента) и Tile Width (Ширина 
фрагмента) проверьте размеры  

 
7 Нажмите Save, чтобы сохранить изменения. 
 
 Примечание: Для сохранения в новом файле 

и оставить без изменений оригинал нажмите 
кнопку Save As. 

 

Управление оригиналами и 
образцами ткани 
 
Рисунки (растровые изображения) могут быть 
вставлены или отсканированы в программу 
BERNINA Quilter для использования в качестве 
оригиналов для оцифровывания или образцов 
ткани. Ткани могут быть одноцветными или 
узорчатыми. Образцы одноцветных тканей 
хранятся в Библиотеке цветов Colors Library, а 
узорчатых тканей – в Библиотеке тканей (Fabrics 
Library). Программа BERNINA Quilter 
предоставляет разные возможности управлять 
вашими узорчатыми тканями. См. также 
Сканирование оригиналов и тканей. 

 
Создание образцов ткани 

 
Выберите инструмент Tile Fabric 
(диалоговое окно Edit) для создания 
собственной ткани. 

 
Диалоговое окно Tile Fabric позволяет создавать 
образцы собственных тканей и сохранять их в 
вашей собственной категории. 
 
Как создать образец ткани 

1 Вставьте или отсканируйте ткань. 
 Подробнее см. в разделе Использование 

изображений. 

 
2 Выберите изображение ткани. 
3 Щелкните по значку Tile Fabric. 
 Откроется диалоговое окно Tile Fabric. 

 
 
4 Щелкните по кнопке Select (Выбрать). 
5 Выберите фрагмент ткани, который будет 

использован. 
 Подробнее см. в разделе Выбор элементов 

мозаики ткани. 

6 Щелкните по кнопке Save As (Сохранить 
как). 
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 Откроется диалоговое окно Save As. 

7 Выберите папку из каталога Manage 

Fabrics или щелкните по кнопке Create New 
Category для создания новой папки.  

8 Введите имя нового файла в поле Save As. 
9 Нажмите кнопку Save (Сохранить). 
 
 
 
Создание категорий тканей 
Диалоговое окно Fabric Library Manager 

позволяет создавать ваши собственные 
категории тканей для упорядочивания и 
классификации ваших узорчатых тканей.  
 

Как создать категорию ткани 

1 Выберите File > Manage Fabrics. 
 Откроется диалоговое окно Fabric Library 

Manager (Управление библиотекой тканей). 
 

 
2 Отыщите требуемое вам местоположение. 

 

 
3 Щелкните правой кнопкой мыши и выберите 

New Category (Новая категория) из 
всплывающего списка.  

 Совет: Вы можете также создавать новые 
категории, используя инструмент Create New 
Categories. 

 Будет создана папка New Category. 
 
 

 
4 Введите имя для новой папки. 
5 Дважды щелкните по новой папке, чтобы она 

открылась. 
6 Введите имя нового файла в поле Save As. 
7 Нажмите кнопку Save. 
 Новый образец ткани будет сохранен в новой 

категории/папкею 
 
Удаление тканей и категорий 
 

Используйте команду Manage Fabrics (меню 
File)  для удаления тканей или категорий. 

 
Диалоговое окно  Fabric Library Manager 
позволяет удалять категории ткани, если в них 
нет больше необходимости.  
 
Как удалять ткани или категории 

1 Выберите File > Manage Fabrics. 
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 Откроется диалоговое окно Fabric Library 

Manager (Управление библиотекой тканей). 
 

 
2 Выберите образец или категорию, щелкните 

правой кнопкой мыши и выберите Delete или 
Delete Category из всплывающего меню.  

 Появится сообщение о подтверждении. 
3 Нажмите Yes. 
 
 Совет: Выберите подлежащий удалению 

файл и нажмите клавишу Delete. 
 

Перемещение тканей в другие 
категории 
 
Диалоговое окно Fabric Library Manager 
позволяет перемещать ваши узорчатые ткани в 
другие категории.  
 
Как переместить ткань в другую 
категорию 

1 Выберите File > Manage Fabrics. 
Откроется диалоговое окно Fabric Library 
Manager (Управление библиотекой тканей). 

 
 
2 Выберите образец ткани для перемещения. 
3 Перетащите мышью образец ткани в новую 

папку в левой части окна. 
 Появится сообщение о подтверждении. 
 
 
Импортирование тканей 
 
Окно управления библиотекой тканей 

позволяет импортировать  файлы BMP или PDF 
 
Как импортировать ткань 

1 Выберите команду File > Manage Fabrics. 

Откроется диалоговое окно Fabric Library 
Manager (Управление библиотекой тканей). 

 
 
2 Щелкните по кнопке Import. 
 Откроется диалоговое окно Import. 
 

 
 
3 Перейдите в каталог с файлом FLB. 
4 Выберите файл FLB для импорта. 
5 Щелкните по кнопке Import. 
 Выбранные файлы будут добавлены в 

библиотеку. 
 
Создание собственных блоков 
пэчворка 
 
Программа BERNINA Quilter позволяет 
создавать вашу собственную библиотеку блоков  
пэчворка для упорядочивания и классификации 
ваших блоков пэчворка. Вы можете 
импортировать новые блоки, создать свои 
категории блоков, удалять или перемещать их.  
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Создание собственных библиотек 
блоков пэчворка 
 
Диалоговое окно Block Library Manager позволяет 
создавать вашу собственную библиотеку блоков 
для сохранения собственных блоков пэчворка. 
 
Как создать библиотеку блоков 

1 Выберите команду File > Manage Blocks. 
 Откроется диалоговое окно Block Library 

Manager. 

 
3 Щелкните правой кнопкой мыши на иконку 

Library Manager и выберите New Library 
(Новая библиотека) из всплывающего 
списка.  

Откроется диалоговое окно Input Library Name.  
 

 
3 Введите имя для собственной библиотеки  
      и нажмите ОК.  
      Знак «$» обозначает собственную   
      библиотеку.  
 
4 Выберите новую библиотеку и щелкните 
правой кнопкой мыши в окне.  
 

 
5 Выберите New Block из всплывающего 
меню. Новый пустой блок будет добавлен к 
библиотеке.  
 
6 Введите имя для нового блока и закройте 

     диалоговое окно.  
 
У Вас теперь возможность отредактировать  
новые блоки, созданы Вами, в Block Library.  
См. также Создание собственных блоков.  

 
Создание собственных блоков 
пэчворка 
 
После создания библиотеки для сохранения 
Ваших собственных блоков и добавления чистых 
блоков Вы можете их редактировать в Block 
Editor.  
 

Как создать собственный блок 
 

 Выберите собственную библиотеку.  

 
 
 Выберите пустой бланк и щелкните на 

Edit. 
 
Выбранный блок откроется в окне для 
обработки блоков Block Editor. 
 
Размер cстандартного блока по 
умолчанию 10 х 10 квадратов.  
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 При необходимосте измените размер 
блоков командой Edit > Block Size. 

 
 Используйте инструменты рисования и 

палитру цветов для обработки блоков.  
 

 
 

 

 

Управление собственными 
блоками  
 
Диалоговое окно Block Library Manager позволяет 
создавать ваши собственные категории блоков 

пэчворка для упорядочивания и классификации.  
Вы можете удалять Ваши собственный блоки и 
категории блоков, если они Вам больше не нужны 
будут.  См. также  
Создание собственных библиотек блоков 
пэчворка 
 
Как управлять собственными блоками 

1 Выберите команду File > Manage Blocks. 
 Откроется диалоговое окно Block Library 

Manager. 
 

 
 
 Выберите библиотеку с собственными 

блоками, обозначенную знаком $.  
 

 Щелкните правой кнопкой мыши в окно и  
выберите New Category из всплывающего 
меню.  
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 Введите имя для новой папки.  
 Чтобы удалить блок или категорию, щелкните 
правой кнопкой мыши и выберите Delete  

 
 

 Используйте это всплывающее меню также 
для копирования и перемещения блоков 
между папками.  
 

 Используйте это всплывающее меню также 
для переименования или редактирования 
блоков при необходимости.  
 

Печать инструкций по вырезке 
 
Можно распечатать инструкции  Rotary Cutting 
для ваших блоков из опции Block Editor. 
См. также Печать блоков, образцов и квилтов 
 

Примечание: не все пэтчи можно вырезать, 
а только те, что состоят из простых форм с 3-
мя или 4-мя сторонами.  Из-за этого в 
готовой инструкции по вырезке могут 
отображаться не все пэтчи. 

 
Чтобы распечатать инструкции по вырезке 

1 В библиотеке  Library, выберите нужный блок 
 

 
2 Нажмите «редактировать» (Edit) , чтобы 
отредактировать блок. 
 

3 Выберите File > Print Preview. (Предпросмотр) 
Предпросмотр имеет ограниченное число функций. 
См. также Печать пэчворк блоков. 
 

 
 
4. Выберите Rotary Cutting Instruciion и нажмите 
ОК. 
 
Выбранный блок отобразится в окне 
предпросмотра. 
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. 

 
5. Чтобы изменить линию отреза, нажмите   
Select (Выбор) 
 

 
 
6 Нажмите кнопку Print (печать) и  

распечатайте диаграмму вырезки. 
 
Примечание: Можно также выбрать в меню команды 
 Файл>Печать 
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ПРИЛОЖЕНИЕ А 
 

ПРОГРАММА BERNINA QUILTER 

КРАТКИЙ СПРАВОЧНИК 
------------------------------------------- 
 
 

 
В этом кратком справочнике подробно описываются все опции меню и панелей 
инструментов, имеющиеся в программном пакете BERNINA Пэчворк и квилт.  
 
Окно BERNINA Пэчворк и квилт  
 
Строка заголовка 
Строка меню 
Строка 
инструментов для 
блокировки 
 
Панель Edit 
(Редактирование) 
 
Панель Arrange 
(Расположение) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Строка меню BERNINA Quilter 
 
Строка меню окна BERNINA Quilter располагает описываемыми ниже выпадающими меню.  
Некоторые из них доступны также через кнопки панелей инструментов. 
 
Примечание: Стандартная клавиша Alt системы Windows® используется для клавиатурных 
команд. Используйте клавишу Alt совместно с подчеркнутой в меню буквой. Для отмены 
операции нажмите дважды клавишу Esc. 

Стандартный панель 
инструментов 
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Меню File (Файл)   Меню View (Вид) 
New Quilt Открыть новый пустой проект 

квилта  
 Show 1:1  Показать квилт в натуральную 

величину.  
Open  Открыть проект.   Show All  Показать квилт целиком.  
Close  Закрыть текущее окно проекта   Zoom In 2x Увеличить изображение  образца квилта 

в два раза 
Insert 
Embroidery 

Вставить существующую вышивку  Zoom Out 
2x 

Уменьшить изображение образца ткани в 
два раза 

Load 
Artwork  

Вставить рисунок  Zoom Box  Увеличить и уменьшить изображение в 
окне проекта и увеличить в 
оконтуренных областях до полного 
размера окна.  

Save  Сохранить текущий проект   Picture  Показать или скрыть рисунок фона.  
Save As  Сохранить текущий проект под 

другим именем, в другом месте 
или формате  

 Grid Показать или скрыть сетку и изменить 
настройки сетки  

Quilt 
Properties  

Добавить комментарии о проекте 
квилта для распечатки.  

 Measure Измерить блоки квилта или размер 
проекта  

Print Печатать проект квилта  Toolbar Показать или скрыть панель 
инструментов 

Print 
Preview 

Предварительный просмотр проекта 
квилта перед печатью 

   

Tile fabric Открыть диалоговое окно Tile 
Fabric (Создание образцы ткани) 

 Меню Arrange (Расположение) 

Manage 
fabrics 

Открыть диалоговое окно  Manage 
Fabrics – для  удаления категории 
ткани 

 Mirror 
Horizontal  

Перевернуть выбранные объекты по 
горизонтальной оси.  

Manage 
blocks  

Открыть диалоговое окно Manage 
blocks - для создания новых 
категорий блоков 

 Mirror Vertical  Перевернуть выбранные объекты по 
вертикальной оси.  

Recent File 
List  

Показать список недавно 
использованных файлов. Выбрать 
файл для открытия.  

 Group Сгруппировать выбранные объекты в 
единый объект. 
 

Exit  Закрыть все открытые проекты и 
выйти из программы BERNINA 
Quilters  

 Ungroup Разделить сгруппированные объекты 
в отдельные компоненты. 
 

Меню Edit (Редактирование)  
 Regroup Объединить в группу предварительно 

разгруппированные объекты 

Undo  Отменить последнюю команду.  
 Bring Forward Перевести выбранный объект на один 

слой вперед 
Redo  Повторить выполнение 

отмененной команды.  
 Bring to Front Перевести выбранный объект на 

передний план 
Cut  Удалить выделение с помещением 

в буфер обмена.  
 Send 

backwards 
Перевести выбранный объект на один 
слой назад 

Copy  Скопировать выделение в буфер 
обмена.  

 Send to back  Отослать выбранный объект на задний 
план 

Paste  Вставить содержимое буфера 
обмена в окно проекта.  

  
Меню Settings (Настройки)   

Duplicate  Дублировать выделение с 
помещением в текущее 
выделение.  

 Object 
properties  

Настроить свойства для 
выбранных форм. 
 

Delete  Удалить выделение без 
помещения в буфер обмена.  

 Options Выбрать настройки для 
отображения окна. 

Select All 
Applique 

Выделить все объекты аппликации 
в проекте.  

 Display Setup  Калибровать экран. 
 

Lock 
Applique 

Блокировать все объекты 
аппликации, чтобы не перетащить 
их по ошибке  

 Scanner 
Setup  

Настройка опций сканера. 
 

Lock 
Embroidery 

Блокировать все объекты 
вышивки, чтобы не перетащить их 
по ошибке  

  
Меню Help (Справка)  

Lock Quilt Блокировать весь квилт, чтобы не 
изменять его по ошибке  

 Help Topics Вывести список тем онлайновой 
справки 

Deselect All  Отменить выделение всех 
объектов в проекте.  

 Online Manual  Открыть отображаемое на экране 
руководство в формате Adobe 
Acrobat (PDF). 

Edit 
Embroidery 

Открыть вышивку в программе 
BERNINA Embroidery Software для 
редактирования  

 About Показать информацию о версии ПО 
BERNINA. 
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Меню Help (Справка)  Меню Wundows (окна)  

Bernina 
International 
Home Page 

Открыть сайт Bernina International   New Window Открыть новое окно 

Bernina 
Internationa 
Home Page 

Открыть сайт Bernina USAl   Cascade Выровнять открытые оуна 

Embroidery 
Online 

Открыть сайт вышивания  Tile 
Horizontally 

Расположить открытые окна 
горизонтально 

Access 
Code. Order 
Form 

Открыть форму закаща в 
интернете 

 Tile Vertically Расположить открытые окна 
вертикально 

   Arrange Icons Расположить кнопки в окне проекта 
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Окно программы  BERNINA Quilter содержит панели инструментов, описанные ниже. 

Некоторые из них являются отсылками к командам из выпадающих меню.  
 
Общая панель инструментов (Standard)          
 

 

New  То же, что File > 
New.  

 
 
 
 

 
 
 

 
 

 

Show 1 : 1 
То же, что View > 1 : 1. 

 
Open  

 
То же, что File > 
Open.  

Pan Используйте этот инструмент для 
панорамирования проекта квилта. 

 
Save  

То же, что File > 
Save.  

Show Fabric  
1 : 1  

Просмотр тканей в натуральную величину 

 
 
Print 

Печать проекта с 
текущими 
настройками 
печати. 

 
Show Fabric 
Average Color 

 
Просмотр тканей со сглаженными 
оттенками цвета 

Print Preview  
 
 
 
Cut 

То же, что File > 
Print Preview. 
 
 
То же, что Edit > 
Cut. 

 
 
Show Outlines 

 
 
Отображать только черные контуры 
блоков квилта 

 
Copy 
 

 
То же, что Edit > 
Copy.  

Панель замков (Lock)          
 

Paste 
 

То же, что Edit > 
Paste.   

   Lock Quilt  
 

Защитить весь квилт 
 

Undo То же, что Edit > 
Undo.  

Lock 
Embroidery     Защитить  проект вышивки 

Redo То же, что Edit > 
Redo.  Lock Appliqué 

 
Защитить аппликацию 
 

Grid То же, что View > 
Grid.   

 

Show/Hide 
Images 

То же, что View > 
Picture.   

Object 
Porperties  

То же, что Settings 
> Object Properties   

 
Zoom Box 

То же, что View > 
Zoom Box.    

 
Zoom In 2x 

То же, что View > 
Zoom In 2x. 
 

  

 
 
Zoom out 2x 
 
 
Show all  

 
То же, что View > 
Zoom out 2x.  
 
То же, что View > 
Show All. 
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Панель инструментов правки (Edit)      Панель размещения (Arrange) 

 

 
Select 

Выбор объектов для изменения 
размеров, перемещения, перевод в 
зеркальное отображение или вращения 

 

 
Group 

То же, что Arrange > 
Group 

Quilt Layout 
Настройка компоновки квилта и 
количества блоков  Ungroup 

 
То же, что Arrange > 
Ungroup 

Library 
Отображение и выбор блоков для 
квилта. 

 
Regroup То же, что Arrange > 

Regroup 

Reshape 
Applique Изменить форму аппликаций 

 
Bring Forward 

 
То же, что Arrange > 
Bring Forward 

Mirror 
Horizontal 

То же, что Arrange > Mirror 
Horizontal. 

Bring to Front 
 

То же, что Arrange > 
Bring to Front 

Mirror  
Vertical  
 

То же, что Arrange > Mirror Vertical . Send 
Backward 

То же, что Arrange > 
Send Backward 

Rotate 90 
Left / Right 

Поворот выделенных объектов шагами 
по 45°. Для поворота против часовой 
стрелки щелчок левой кнопкой мыши. 
Щелчок правой кнопкой – поворот по 
часовой cстрелке. 

 
Send to Back 
 
 
 

То же, что Arrange > 
Send to Back 
 
 

Scale by 20 
% Down/Up  
 
 
 
 
 
Adjust Hue/ 
Brightness 

Изменение размера выделенного 
объекта шагами по 20%. Щелчок 
левой кнопкой – уменьшение, 
правой кнопкой – увеличение 
объекта.  
 
 
 
Настройка оттенка или яркости 

Align Left 
(Vertical) 
 
Align  
Centers 
(Vertical) 
 

Выравнивание 
выбранных объектов по 
левому краю. 
 
Выравнивание центров 
выбранных объектов 
по вертикали. 

Align Right 
(Vertical) 

Выравнивание 
выбранных объектов по 
правому краю. 

Dim Picture Понизить или повысить 
яркость изображения, чтобы более 
четко видеть квилт 

Align Top 
(Horizontal) 

Выравнивание 
выбранных объектов по 
верхнему краю. 

Paintbrush Выбор и добавление блоков 
пэчворка к квилту 

Align Middle 
(Horizontal) 
 

Выравнивание центров 
выбранных объектов 
по горизонтали. 

Eyedropper  
 
Embroidery 
Window 
 

Выбор блоков или тканей.  
 
Открыть проект вышивки в 
собственном окне Embroidery 
Window. 

 
Align Bottom 
(Horizontal) 

Выравнивание 
выбранных объектов по 
нижнему краю. 

Rectangular 
Applique 

Создать прямоугольные аппликации Align Centers Выравнивание центров 
выбранных объектов 
по центру проекта. 

Oval 
Applique 

 
Создать овальные аппликации 

 

  

Draw 
Applique 

Создать аппликации произвольной 
формы 

 
Scan 
Picture 

 
Сканирование изображения в ПО  
BERNINA. 
 

  

Tile Fabric Показать фрагмент ткани по всему 
окну ПО 

Load 
Picture 

Вставка изображения в окно 
проекта. 
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ПРИЛОЖЕНИЕ В 
 

СТАНДАРТНЫЕ КОМБИНАЦИИ 

КЛАВИШ 
------------------------------------------- 
 
В программе BERNINA Embroidery Software, как и в других приложениях  MS Windows, одни и 

те-же команды можно вызвать из строк меню или с панелей инструментов. Самые частые 
команды вызываются также стандартными комбинациями клавиш. 
 
Общие функции    
    
Функция Нажать Функция Нажать 

    
Отменить Esc Защитить вышивку Ctrl+Shift+E 
Выйти из программы Alt+F4 Защитить квилт Ctrl+Shift+Q 
Открыть  Ctrl+O Отменить выделение X 
Распечатать проект Ctrl+P Редактировать вышивку E 
Сохранить проект Ctrl+S   
Создать новый проект Ctrl+N   
    
Просмотр проектов  Упорядочить  
    
Функция Нажать Функция Нажать 

    
Измерить расстояние M Группировать объекты Ctrl+G 
Масштаб 1Ж1 (100%) 1 Разгруппировать Ctrl+U 
Показать весь проект 0 Перегруппировать Ctrl+R 
Показать контуры Ctrl+L На передний план Shift+Page Up 
Выделить B   потом мышь Переместить вперед Page Up 
Увеличить х2 Z    или колесо мыши Переместить назад Page Down 
Уменьшить х2 Shift+Z или колесо мыши На задний план Shif+Page Down 
    
Редактировать проект    
    
Функция Нажать   
    
Повторить действие Ctrl+Y   
Отменить действие Ctrl+Z   
Вырезать выделенное Ctrl+X   
Копировать выделенное Ctrl+C   
Вставить Ctrl+V   
Копировать объект Ctrl+D   
Удалить выделенное Delete   
Выбрать аппликацию Ctrl+A   
Защитить аппликацию Ctrl+Shift+A   
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ПРИЛОЖЕНИЕ С 
 

ОБРАЗЦЫ ШАБЛОННЫХ КВИЛТОВ 
------------------------------------------- 

 
Образцы шаблонных квилтов «Holice Turnbow», показанные в этом приложении, включены в 
вашу программу BERNINA. (Онлайновое Руководство содержит полный ассортимент элементов 
„Holice Turnbow“. Вы можете получить к ним доступ из меню Help (Справка) программы 
BERNINA artista.) Реальные проекты (файлы ART) можно найти в папке My Designs/Holice 

Turnbow Stencil Quilt Designs. Некоторые образцы представлены как в уменьшенном, так и 
в увеличенном формате – например, HT105 и HT105LG. 

 
Внимание: Образцы в папке «Holice Turnbow Stencil Quilt Designs» были созданы Holice Turnbow. Эти 
образцы защищены авторскими правами для эксклюзивного пользования зарегистрированных 
пользователей ПО BERNINA Embroidery Software. Запрещено копировать эти образцы, передать или 
продать их лицам, которые не являются владельцами  ПО BERNINA Embroidery Software. 
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